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Quick Start

Contract Setup

Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and
quotes window setup.

Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see
all of the contracts included in that window. Click to add a checkmark next to the contracts you want to see in
your drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

Once you have added the desired contracts to the contract setup “Selected” box you will next want to select
the months that you want to trade. If you change the month’s column to the “Nearest 2” selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the
contracts then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back
in.

& Contract Setup

BE=X

Available: Selected:
+ Currencies Description Sumbol | Monthe -~
= Energies Auzsie Dollar = MNearest

BH - Heating Oil Brritish Pound 6B MNearest
CL - Crude Ol [pit] Canadian Dollar B Mearest
GCL - Crude Oil Euro Fi Currencies EE Mearest
GHO - Heating il Japanese Yen A Mearest
Brazilian Real EL Mearest
GHL - Unleaded Mexican Peso G Mearest
GNG - HH Natural Gias New Zealand D ollar BN Nearest
HH - Matural Gas Last-day Fussian Ruble GR Mearest
HO - Heating Ol [pit) Swizz Franc BS Mearest
HF - Natural Gas Sauth .t’-‘«fric_:an Fand B2 Mearest
HU - Unleaded [pit] Ethanal [pit] AC MNearest
NG - HH Natural Gias [pit) (e Dot pi) W e
06 - HH Matural Gas mity H;‘;“t::;”&i[f' ) o -
GH - Heating _D'I r"'NY Sopbean Ol [pit] BO Mearest
0k - Crude Ol ity Biritish Pound [pit] BP Mearsst
QU - Gazoline miky' Brazilian Real [pit] BR Mearest
ET -RBOBE Gazoline Carn [pit) C Mearest
WS - Crude Ol Cocoa [pit] _ [ Mearest
5 Financials Canad|a_n Dl-:-IIar [pit] CD Mearest
. Girains Crude il [pit) CL Mearest
] Indi Cottan Mo, 2 [pit] CT Mearest
* nOIGes DA [pit] DJ Mearest
- [v] Meats 1S Dallar D Nearest
+ Metals E-tdini Eura Fx E7 Mearest
+ Softs Ewro F= Currencies [pit] EC Mearest
Eura Dallar [pit] ED Mearest
{1 Mo, LIBOR [oit) Erd MNearest 5 hl

e  Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and

click “OK”.

Account Summary

You can customize the "Account Summary" window by hiding the rows that you do not want to see.




Account Summan E
Tatal
Proht{/Loss
Open PAL $0.00
Realized P/L $13.875.00
Total P/L $£12.875.00
Balance
Cash $ B4, 765.00
Open PAL 0.00
Met Lig $ B4, 765,00
F ate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summan E
Tatal
Proht{/Loss
Open PAL $0.00
Realized P/L $13,875.00
Total PAL $£12.875.00
Balance
Cazh % B4.765.00
Open PAL 0.00
Met Lig % B4.765.00
R ate
Al Currencies
| Column Setup. ..
Fork...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.

[ =,
m Account Summary = @
Colurmn igibility
Open PrL Hidden v
Fealized P/L
Total PAL Eg‘l’dma'
Cash Hidden
Open PAL TTarmmal
Met Lig Mormal
Fate Marmal
aE. l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.
Total P/L shows the total P/L for both the Open and Realized P/L.

Quick Start
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Account Summan

Tatal 5D CHF
Profit/Loss

Open P/L $0.00 .00 0.on
Fealized F/L -5 95.00 -35.00 0.on
Tatal PAL -5 35.00 -35.00 0.o0

» | all Currencies
A0,167.50 n.09
Colurmn SEtL‘EI .00 Q.00

UrFEnCies
Export bo C3W, o0 E?.51EI ?Dégg
= Fant. ..

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in OECTrader. This gives the trader an opportunity to
confirm the order before the order is sent for execution. This feature is optional and is turned on by default.

m OECTrader Demo

File  Account | Orders | Communications  Quotes  Wiew  Reports  Setup Toolbox  t

Abbreviated Order Enkry Zhrl+1
Symbal | #Bo Turba Order Entry Chrl+2 Poz| $Tatal PAL
ECUG Rapid Order Enkry Chrl+3 5 $550.00
ESLE 10 $2.625.00
Depth OF Market Order Entry Chrl+4
Crder Defaulks, ..
1 v )
Awverage Position Clear After Submit
I Contrack Setup,..
Account | Confirmations 3 | Mew Order
DEMD25830 Natifications g Cancel Order

Shows Cancelled Crders
Show Rejected Orders

[ mr [
m Order Confirmation
— Account: DEMO 25830
a Send BUY 5B BAUG MET?
[ k. ] [ Cancel

Notifications



Quick Start

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel

Failed".

m OECTrader Demo

File  Account

Symbal | #Ba

ECUG
ESUE

Average Position

Account
DEMO25830

Crders | Communications Vieww  Reports  Setup Toolbox  Help 0
Abbreviated Order Enkry Chrl+1
Turbo Order Enkry Chrl+Z Pos| % Tatal PAL
Rapid Order Enkry Chrl+3 5 $300.00
10 $2,750.00
Depth OF Market Order Entry Chrl+4
Order Defaults, .
Clear After Submit
Cankrack Setup...
Confirmations Surnhbinl Price Last Croc

Matifications

Show Cancelled Orders
Show Rejected Orders

| New Fil
Modify or Cancel Failed

m OECTrader Demo

-,

Cloze

\"ll) & Fill [100521 298, 25] has been added into Order #783150

Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order

accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.

Decide if you would rather hear a sound or see an alert box.

To access Sound Alerts:

a. Communications > Sound Alerts
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m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fill Received <default: Alert Bow
k odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [zzued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

To configure:

a. Highlight the channel that you want to assign the sound to.

b. Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files
are located: (C:/WINDOWS/Media)

c. Hit "Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you
want sounds only.

e. Hit "OK"



Overview
File

Logon

When disconnected from the OECTrader, selecting Logon will present a dialog box to connect. This will require your
Username and Password. As an option you may also select for the OECTrader to Auto Reconnect in the event you
lose connection from the OEC servers. Once the Username and Password have been filled in click Logon to connect
or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uzer Mame: |UserTest

m OECTrader Demo Password: |1

File | Account  Orders
Yerson: 3.1.0.4
| Logan
Ay, Auto Beconnect
Exit [ Logon H Canicel
Logoff

To logoff the OECTrader, select File then logoff. This will present an Exit Confirmation dialog box recapping your
daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
OECTrader on your screen however it will be logged off from the servers.

m QECTrader Demo

File | &Account  Orders

| Logoff | Ag.

Exit Logoff

Exit

This feature will provide the same functionality as the Logoff and in addition it will close the entire OECTrader
application.
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m OECTrader Demo
File | Account  Crders
Logoff B
Exit |l
m Exit Confirmation
1 Wiorking Orders
1 Filled Drders
Accaunt Symbal | #Prev | #Bought | #5aold | Met Pos
DEMOZ5830 BCUG ] 1] 0 ]
DEMOBE3SS BCLG -h 1] 0 -h
DEMOZ5830 ESLG 10 1] 0 10
DEMOBE3595 ESLUE 20 20 1] 40
E =it l [ Stay Logged On
,ACCO unt

m OECTrader Demo

File | #ccount | Orders  Communications

Average Positions

Sy Detailed Positions Id
ECLI ]
ESL Select fccaunt L

Account Filker, .

Average positions
Displays the average positions open on each specific contract that has been traded.
In order to go flat in a specific contract:

a. Inorder to go flat in a specific contract, left click on the position and click on "Exit F2". This will immediately
transmit a market order for the contract selected to flatten the position.

b. Inorderto go flat in all current contracts with open positions left click the "Exit Al"l. This function will
immediately transmit a market order to exit all contracts with open positions.



Overview

Average Poszitions LA
Symbal | HBought | Awg. Buy Price | #5old| Awg. Sell Price | MetPos|  § Tatal PAL| | E¥EFS
Exit all

ESLIE 20 1293.75 1] 0.00 20 $260.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

Detailed Positions ERER|
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Fealized PAL Open P/ Tatal PAL || EEF2
Exit &l
ESLE 1293.75 0.00 20 noouso 2a0.000sSD 28000150

Select Account

If trading multiple accounts, left click the upped area where it says "Account: DEM0O85399", choose the account you
would like to trade. This same function can be accessed by the keyboard function CTRL-A.

=

Accounk: DEMOSS399

DEMOZ5E30
DEMOB5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the OECTrader.

Select Always Show Selected Account and the OECTrader will automatically display the orders of the selected
account.

@ Account Filter Dialog M

DEMOZ5830
DEMOB5333

Alwans Show Selected Account

| Toogleasl || cCiearan || ok || Cancel
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Orders

m OECTrader Demo

Symbaol | HBo

BCUE
ESUE

<

-.-’-'-.v.erage Position

Account
DEMO2R830

File Account | Orders Carmmunications Quotes  Wiew

Repi

Abbreviated Order Enkry Chrl+1
Turbo Order Enkry Chrl4+2
Rapid Crder Enkry Chrl+3
Depth OF Market Order Enkrw Chrl+4

Crder Defaules, ..
Clear after Submit

Contrack Setup...
Confirmations

Motifications

Show Cancelled Orders

Show Rejected Orders

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform

Side bdarket Selection

(%) Buy Cluamtity Symbiol

O Sel 0 v [Esus ]
Order Specs

Type: | Market v Flag: | Mone

| BLMT F3 | | B-MKTF4 |

Mew Order F8 | | S-LMT F5 | [ 5-MKT Fé |

Template:

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently

c. Allows you to load and save orders from excel.

10




Turbo Order Entry

Account

[] DEMO25830
DEMOZ5830
DEMO25330
DEMO25330

Side
Buy
Sell
Buy
Buy

ity
4
15
4
15

Symbol | Type
BALIE b arket
ESUE Lirnit
BELIE b ark.et
EDUE b ark.et

Flagz Frice
Mone
GTC 1.50
MHaone
MHaone

Overview

e
.

Frice2 | Status
Ready to zend
Feady to zend
Ready to zend
Ready to zend

¢ | ¥
Mew Crder Transmit B-LMT B-MKT S-LMT S-MKT | Submit Al Delete Clear |[&FLoad _
Rapid Order Entry (ROE)
Advanced method to trade with specific amounts and settings.
Rapid Order Entry EAE
Auta Factor Settings
Bup StopLimt (0.00 (4] (0.00 2] Stop 129575 %] Limit 129575 2]
Sedl Lirit oon 3 Limit 1295.75 |2 Sell Limit
[(uiantity Symbaol
0 | [Esu v Last 129575
. . Size =

Bid 129560 .. Sell Bid
Auto Factar Settings
Buy Limit 000 3 Limit 1295.75 |2
Sel StopLimit 0.00 (2000 |2 Stop/1295.75 |2 Limit129575 |2

Depth of Market Order Entry (DOM)

Allows you to launch DOMs from here

[N

1
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Depth Of Market Order Enty (4]
Symbol: |BAUE | Syrbol v
Symbal: V Symbal: v
Symbal: V Symbal: v
Swrnbal: V Symbal: v
Symbal: V Symbal: v

Order default

Can create default orders for each account what will appear when a new order is being placed after clicking on NEW
ORDER in the AOE.

mﬂrder Defaults

Account DEMO25830 v
Drefault Order for

Buy/Sell: By V

Syrnbaol; ESUE

OrderT ppe: b arket

Flag: Nore |+

[ k. ] [ Cancel

Contract Setup

1. Every contract that appears in the SELECTED box will appear in the drop boxes
2. Can add market and groups
3. Can customize each contract

4. Give each contract a default quantity (QTY).

5. Change the contract months that are traded.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in OECTrader. This gives the trader an opportunity to
confirm the order before the order is sent for execution. This feature is optional and is turned on by default.
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Overview

[ ] ] [ Cancel

Notifications

File  Account | Orders | Communications  Quotes  Wiew  Reports  Setup Toolbox  t
Abbreviated Order Enkry Chrl+1
Symbal | HBo Turbo Crder Entry Chrl+2 Foz| ¢ Tatal PAL
BCUE Rapid Order Enkry Chrl+3 3 $250.00
ESLIE 10 $2. 625,00
Depth OF Market Order Entry Chrl+4
Crder Defaults. ..
v )
Awerage Position Clear After Submit
Contrack Setup..,
Account | Confirmations 3 | Mew Order
DEMD25830 Notifications r Cancel Order [
Show Cancelled Orders
» | Show Rejected Crders
FA i [
Order Confirmation
- Account: DEMO25830
O Send BUY 5 GAUG MET?

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation

failed.

13
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m OECTrader Demo

File  Account | Orders | Communications  Quotes  Yiew  Reports  Setup Toolbox  Help (

Abbreviated Order Entry Chrl+1 |
Spmbal | #Ba Turba Order Entry Chrl+2 Pos| % Tatal PAL
UG Rapid Crder Enkry Chrl43 ] $300.00
ESLE 10 $2.780.00

Depth OF Market Order Enkry Chrl+4

Crder Defaults, .,

.. w | After Submik
Ayerage Position =ar ATter SUbm

Conkrack Setup...

Account Confirmations r Surmhinl Frice | Azt Croc

DEMOZ5630 | Motifications I hewr I
show Cancelled Crders Modify or Cancel Failed
Show Rejected Orders

.

m OECTrader Demo

\ l) A& fill [100231 238, 25] has been added into Order $733150

Cloze

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account Order # | State Side [t | Symbol | Awg.Price
DEMOZ5830 778834 Cancelled By 0/3 ESUB
DEMOBR359 780523 Completed By 20420 ESUB 1297.75
DEMOBR359 783150 Completed Sell 10410 ESUB 1298.25
DEMOZ25830 783288 Rejected By 000 BCUE

Communications

Sound alert

e  Customize different alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

®  You can customize with any .wav file or our programmed files which come with the software

e  Decide if you would rather hear a sound or see an alert box.

14
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m Alert Settings

Channel Sound Level
Cancel Failed < default: Alert Bow
Dezk Meszage <default: Sound
Fill Received <default: Alert Bow
k odify Failed <default: Alert Bow
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order [zzued <default: Sound
Order Rejected <default: Alert Box

<default: v E

Level | Alert Bow L

o) (o)

Message History
e  See your message with the broker you spoke with, when about what and what the broker said.

e  Click on view to view within the software or PDF to export into a PDF file or Excel to export into a .exe file

¢ Message History

File
Begin Date: End Date:
08/23/2006 00:00  [»| | 08/23/2006 2353 [+ | view | [ _POF | [ Escel |
H 4 Page1of1 bk M =]
Chat History for DFormica57
Time From -> To M
08/23/2006
15:28:33.607 DFormicas? -= Danield  |Hello I have a question.
15:28:47.170 DFormicas?y -= Danield | What is the current symbol of th
15:29:13.513 Daniels -= DFormicas? | The current symbaol for the mini =
15:29:23.763 DFormicas? -= Danield | Thank you !
15:29:35.730 Danield -= DFormicas? | Your Welcome!

15
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Chat/Research Windows

Close/Open

Click on the RESEARCH options; if the option has a check next to it then it's available to view; if it doesn’t have
a check then it isn’t available to view.

3:41:39 PM RISK
Rigk wiolation Max credit = 0 USD,Order would need credit of 6012.52
S0 [zash available iz 37862.48 1SD]

Click on the CHAT option. If it is already checked it will uncheck the CHAT option and it’ll be unavailable to
chat.

Chat

3:28:36 PM to DanielA:Hello | have a question. | | Danield,
3:28:50 PM to D anield hat iz the curent spmbol of the

rini SP 500 7

3:29:17 PM Danieli: The curent zpmbol for the mini SEP

A00 iz ESUR -

D-0-DF Dl b D cmin A Tl oman |

Quotes

16
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File  Account  Crders  Commmunications
Average Positions
Symbal | #Bought | Avwg Buy Price | #5old
ECLG 1] 0.0o 1]
ESLE 1] 0.0o 1]
Awerage Positions | Detailed Positions |
Open Orders
Account Order | State By
[i] 1
Abbreviated Order Enty
Side kdarket Selaction
(*) Buy Quaritity Symbol
O el 0 vl |2vEEE
Order Specs
Type: | k arket &I Flag: [

Quotes | Yiew  Repaorks

Setup

Add Market

add Market Group
Remove Market
Remaove All Markets

Insert Blank Line

Movwve Up
Mave Dawn

Sort By Alpha

Cuskom Price Format
Fonk...

Rename...

Add Price Alert
Remaove Price Alert

Wiew Price Alerts, ..

LM
Chart

Colurmn Setup. ..

Expork ko C5V...

Add Remove Market and Group

Add Market
a. Add a market by contract
b.  Pit contracts are snap-shots

c. Electronic contracts are streaming

-,

m Market Selection

Contract Title: | BALIE

]

| oK

H Cancel ]

Add Market Group
a. Add an entire Market Group

b. Nearest month or all months

Overview
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m Market Group Selection
Group Title: b onths:
Curmencies w MHearest 1 | w

k. ] [ Cancel

Remove Market

Remove the highlighted market from the Quotes window.

Remove All Markets

Remove all markets from quote window.

Customize Appearance

Quotes
Swrnbal Last| Lastol Bid| BidSize Bk | BzkSize ||
ESUE 1297.50 1 1297.25 527 1297.50 340 1
HOUE 1857.00 13 1557.00 13 1857.25 261 1
ERZUG £33.2 g £33.1 31 £393.2 3
ZBUE 11000 1 11000 1477 1100 276
ZHUE 106 30.5 30 106 30.0 3245 106 30.5 728 10
ZrGEHE B23.3 1 £20.4 3 621.5 1

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

Move up/Move Down
Move the highlighted contract up/down

Sort by Alpha

Sort all the contracts in the Quotes window in alphabetic order
Customize Format

Custom Price Format
Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.



m Price Format
BSLE

Default Format Default Mulipler
wiZ * 000000
wid *0.00001
/8 *0.0001
w16 *0.00
w3 *00
/B4 01
w128 “1
n/256 10
0 100
na #1000
Q.00 *10000
0.oon *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000

Apply ] [ Cancel

Font

Customize the font of your Quotes window.

-

Font RX|
Eant: Font style: Size:
Microsoft Sans Serif Fegular g [ Qg ]
€} Microzoft Sanz Serf [ | | Fegular g e
{} Monotype Corsiva [talic: 9
{3 M5 Outlook Bold 10
(} M5 Reference San: S| | Bold Italic 1A
{} M5 Reference Specia 12
O MY Boli 14
{} Palatino Linotype M 16 (¥
Effectz Sample
[ ] Strikeout
AaBbT
[ ] Underline aBbYz2
Script;
|'W'estern EI
Rename...

Ability to rename the title of the Quotes window.

Overview
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P . Quotes T est
Custom name of Quote... Symbol Last [astVol Bid BidSize
et et e ESUG 1297.75 10 1297.50 528
' 6ALG 76.16 4 76.16 7
Quotes Test 6CLIG 90.11 1 90.11 17
6ELIG 127.81 3 127.81 22
[ ok ] [ Cancel 6JLIG 8.614 1 3.613 240
6SLG 4§09.3 (i} 309.1 21

Quote alerts

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.

-,

m OECTrader Demo

Alert Price | 1293.00 : () <=
O =

) Auto
Alert Test [optional]
ESUE went below or equal ta 1233.00

(] ] [ Cancel

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price
Alert".

View Price Alerts...

View all current price alerts. To remove one alert, select one alert and hit "Remove". To remove all alerts, just
hit "Remove All".

20
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Market | Price
ESLE <=1298.00 ESUE went below or equal to 1293.00

IJzer Meszage

Edit

Femove Fiemove All

View
Yigw | Reports  Sektup  Toolbox

Lock Windows |

Show Tabs
Layaut 3
Positions 3
Accounk Surnrmary
Cpen Orders
Completed Orders —
Order Tickets 3
Cuokes
Depth of Market r
Charts k
Communications 3 =

Lock/Unlock Windows

stay in the current location and are not configurable.

1.
2.
desired.
Layout
Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

Overview

Click on View, and then LOCK WINDOWS. When a check is next to LOCK WINDOWS then the windows will

If there isn’t a check next to the LOCK WINDOWS option the windows are unlocked. Please configure as

21
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Save Layout

Enter name af layout;

MuLlayout]

[ Ok, ] [ Cancel

Once the layout is saved it will be available under View > Layouts.

Wiews | Reports  Setup Toolbox  Help Open a Live Account
Lock Windows
Show Tabs
| Layauk L4 | Save...
Positions 3 Delete. ..
Account Summaty Restore Default Lasyout
Cpen Orders MyLayoutl
Completed Orders —_——————
Crder Tickets 3
Quates Account Order #
DEMOE5399 7Fa0529
Depth of Market r — DEMOBE339 Fa3180
harts , DEMOZ5830 Fa3258
DEMOE5339 Faa704
Cornrnunic ations » b
Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".
Configure windows

Positions Window

Ability to toggle back and forth from Average Positions to Detailed Positions.

Wigww | Reports  Setup Toolbox  Help Dpen a Live Accou
Lock Windows
Show Tabs Total AL
Lavout » SF200ush
-288.00 USD
| Positions L4 m Average Positions "
Account Surmmary Detailed Positions
Cpen Orders

Other Windows

22
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Account Summary, Open Orders, Completed Orders, , Order Tickets, Quotes, Depth of Market, Charts or
Communications.

Access Reports
Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.

Daily Fills

Shows the daily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire OEC population. These
messages are important details from the broker involving major Futures issues.

Order Details
Provides a detailed description of each trade made and the necessary identifications for each detail within the

order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Provides the list of open orders that exist with in that account.

Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of OEC Trading options.

Actian Feys -~
File
Logaon
L ogiff
E xit
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Entry tadifiers:
Rapid Order Entry )
Drepth Of Market Order Entryp Cul [] shift [ ] A
Contract Setup Key:
Clear After Subrmit
1 | | Beset
Turn on Mew Order Confirmation
Restore Defaulq [ ak. ] [ Lancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and all
the contact info for customer service and support.

24
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-,

rm Quick Start = @

HEE N BN L i
open e cry"

Welcome to Open E Cry's direct access trading software.

We encourage vou to vigit our quick start guide and in depth uzer's
guide.

If vou have any questions please visit our Live Help or call 200-520-
5308 or 814-792-2590,

A link to the quick =tart guide will be available under the "Toolbox™ menu
of the goftware for future reference.

[w] Show an startup

Toolbox

Contract List
Display the Open E Cry's Contract List web page with your default browser.

URL: http://www.openecry.com/platforms/available.cfm

Contract Margins
Display the Open E Cry's Contract Margins web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/margins.cfm

Contract Specs
Display the Open E Cry's Contract Specifications web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/contract.cfm

Glossary
Display the Open E Cry's Glossary web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/glossary.cfm

Help

Contact Us

25
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Display the Open E Cry's Contact web page with your default browser where you can direct questions/comments to
our staff.

URL: http://www.openecry.com/company/contact.cfm

About

Displays the current information of the platform that the trader is currently running.

rm About

DECTrader Demo

HEE B BER L B Version 3.1.05

@ 2006 Open E Cry, LLC

1
0 p e n e c ry All rights reserved

Open Live Account (DEMO ONLY)

Demo Only

Display the Open E Cry's Online Application with Electronic Signature web page with your default browser.

URL.: https://www.openecry.com/openaccount/applyonline.cfm

26




File

Logon

When disconnected from the OECTrader, selecting Logon will present a dialog box to connect. This will require your
Username and Password. As an option you may also select for the OECTrader to Auto Reconnect in the event you
lose connection from the OEC servers. Once the Username and Password have been filled in click Logon to connect
or Cancel to abort the process. Note:(Username and Password are case sensitive).

-,

m OECTrader Demo

Uzer Mame: |UserTest

m OECTrader Demo Password: |1

File | Account  Orders
Yerson: 3.1.0.4
| Logan
Ay, Auto Beconnect
Exit [ Logon H Canicel
Logoff

To logoff the OECTrader, select File then logoff. This will present an Exit Confirmation dialog box recapping your
daily activity. From this dialog box you can confirm the Exit or Stay Logged On. This selection will keep the
OECTrader on your screen however it will be logged off from the servers.
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Orders

File | Accounk

Logan

Exit Logoff

m Exit Confirmation

Wwhorking Orders
Filled Ordlers

Aocount Symbol
DEMOZ5830 BCUG

DEMOZ5820 ESUE
DEMO85353 ESUE

#Bought | #5old | Met Pog
1] 0 4]

1] 0 10

20 0 40

E xit

] [ Stay Logged On

Exit

This feature will provide the same functionality as the Logoff and in addition it will close the entire OECTrader

application.




m ﬂ!! | raaer BEI“D

File | Account  Orders

Logan

Logoff B

rm !l’l! Eunllrmahun E

!

Wworking Orders
Filled rders

DEMOZ5830 BCUE

DEMOZ5820 ESUE
DEMO85333 ESUE

Account | Symbol | #Prev| HBought| #5old| MetPos|

5 0 1] 5
10 0 1] 10
20 20 1] 40

E xit

] [ Stay Logged On

File
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Average positions

Displays the average positions open on each specific contract that has been traded.

In order to go flat in a specific contract:

In order to go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately

a.
transmit a market order for the contract selected to flatten the position.

b. In order to go flat all current contracts with open positions left click the Exit All. This function will immediately
transmit a market order to exit all contracts with open positions.

Symbal | HBought | Awag. Buy Price | #Sald | Awag. Sell Price | Met Pos % Total PAL
BCUG 1] Q.00 ] 90.03 -5 SR0.00 | Exit Al
ESLE 20 1293.75 1] Q.00 20 $260.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.

4| ¥
Symbal | Awg. Buy Price | Awa. Sell Price | Amount Fealized PAL Open P/ Total P/L
ECUE .00 a0.03 B noouso -10000sD 1000 LSD | Exit Al
ESLE 1293.75 0.00 20 noouso 2a0.000sSD 28000150

Select Account
If trading multiple accounts, the trader has the ability to switch from one account to the other to trade.

Left-click the upper right area where the current account number is being displayed. Or, Keyboard function
CTRL-A

a.

b.  Check the account that you want to trade.

BEX

Account: DEMOEEZ99

DEMOZ5E30

DEMOE5399

Account Filter

The Account Filter allows the trader to select any account they are assigned to see Open or Completed Orders on
the OECTrader.
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Select Always Show Selected Account and the OECTrader will automatically display the orders of the selected
account.

m Account Filter Dialog = @

DEMOZ5830
DEMOZE393

Alwayz Show Selected Account

| Tooglea || ceaan || ok || Cancel
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Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

e

Side bdarket Selection
(%) Buy Quantity Symbol

1] ESUE
Order Specs
Type: | Market v Flag: | Mone v

| B-LMT F3 | | B-MKT F4 | Template: v

| New OrderFa | | 5-LMT F5 | [ 54K FE |

Side

Buy

Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is
called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery
date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol

Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type
Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
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Limit (LMT)
Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has

been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:

1. They are activated when the price reaches the order level
2. They become MKT orders once they are activated

MIT orders are used differently from STPs.

Buy MIT below the MKT price to establish a long position.

Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.
Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique
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allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag
Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (I0OC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a. i.e,BUYtheES at5QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

b. Traders can have as many Templates as desired for quick an easy trading made for the trader.
c. You can have different template for the same contract.

d. DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a. Inorderto EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

b. Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract
a. Place atrade by clicking TRANSMIT

b.  Remove the current order information for a new trade by clicking NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time
b.  Can transmit multiple orders concurrently

c. Allows you to load and save orders from excel.
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Turbo Order Entry (AR
Account Side Gk | Symbol | Type Flagz Frice | Prce2| Status

[+] DEMOZ5830 By 4 BALIE b arket M aone Ready to zend
DEMOZEE20 Sell 15 ESUR Lirnit GTC 1.50 Ready to zend
DEMOZ5330 Buy 4 BEUEG b arket Mone Ready to zend
DEMOZ25830 By 1% EDUEG b arket Mane Ready ta zend

L4 >

Mew Order Transmit E-LMT B-MKT S-LMT S-MKT | Submit Al Delete Clear | [ Load :

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP
a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price
The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;

PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.
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Price2

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status
1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT
b.  Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)
Advanced method to trade with specific amounts and settings.

R apid Order Entry ]
At Factor Settings

w

Bup StopLimt 0.00 4] (000 [2 Stop| 129575 (4] Limit 129575 (&
Sell Limit 000 3 Limit | 1295.75 |3 Sell Limit
[uiantity Symbal
0 | [ESUE v Last 1295.75
- . Size -

Bid 129550 | . Sell Bid
Auto Factor Settings
B Limit 000 3 Limit |1295.75 |2
SellStop Limt 0.00 (2] (000 3] Stop129675 2| Limit129575 3

Auto Factor Settings

Buy Stop Limit
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e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

e  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop
Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

° Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

° Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price

Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size
The number of buyers at the bid price

Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

e  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e  No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

e  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

e  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e  Can only be executed at the limit price or higher.
Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch”.
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Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leurck
Symbok | |%| Leunch | Swmbek | [s]| Lewrch
Symbok | %] Lawnch | Spmbok | [s] Laween
Symbok | [w| | Launch | Spmbok | || | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wigw | Reports  Setup  Toolbox  Help Qpen &

Lock wWindows

Show Tabs Tatal P/L
Layout y | -250.00USD
Positions »

Account Surnmary

Open Orders

Completed Orders

Order Tickets 3

Cuotes

Depth of Market 3 m Blew., ..

Charts k ESLIG

Communications GELIE
E7LS

e  The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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# DoM

-,

Account: |DEM|:|85399

[

Contract: | ESLIE

[

| ok

H Cancel l

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wiewd | Reports  Setup Toolbox  Help Cpen &
Lok Wwindows
Shows Tabs Tatal PAL
Layout v | ooouso
Positions »
Account Summmary
Cpen Orders
Completed Orders
Order Tickets 3
Quokes
Cepth of Market 3 | Mew, .,
Charts 3 | Eelle
Communications GELE
E7LG
Quotes

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

quote you have highlighted.

Quotes Test Add Price alert
Symbol

ESUG 1

GALG

6CLIG DOM
FDAXUG chart

6EUG ar

6.6 Column Setup. .
gf:;ﬁ Export ko 25V,
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DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price alert
Symbol 4
ESUG 1 |
GALG
GCLIG Do |
FDAXUG hart
ﬁE‘Jﬁ 3
616 Colurnn Sekup.. .
gf:;ﬁ Export ko 25V,

View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup Toolbox  Help Qpen ¢

Lock Windows
Shiov Tabs Total PAL

Lavout . 0.00 USD

Positions »
Account Summary

Open Crders

Completed Orders

Order Tickets 2

Quokes

Depth of Market 3 | Mew, ..

Charts » | -

Communications SELE
E7LG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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¥ ESU6 - Depth of Market

DEEX)

Open
Cha
DEMOS5399 -

- e A SN 1
Q. | 1013 TotalPAL: ()¢ 3000.00
FPos: 20 (= 1305.00 [ Exit at MET ] [ Reverze ]

r
1302.00
1302.75
1302.50
1302.25
1302.00
-
| BuwMKT || Gotolast || SelmkT |
Bid
# 6A76 - Depth of Market M=)
=R | [ 5 |efF ¢ 35 (| DEMOZ9sss -
Oty T4 TotalPA $0.00
Pos: 0
| CancelBids || Cancelan |
-
T
1 528
Left Click: LIMIT |75 27 I
Right Click: STOP EE.EE e
5 I
-
| BuwMKT || Gotolast || selmkT |

Right Click: STP
1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2.  The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT
1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price
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'@ 6AZ6 - Depth of Market Lo&
= | [F 5 |aF v A G || DEMOggsss -
Oty 1% Tatal PAL $10.00
Pos: 1@7529) | Exit atMKT | | Reverse |
| CancelBids || Cancelall || CancelOffers |

Left Click: LIMIT

[ Buy MET ] [ o to Last ]

Right Click: STOP

Right Click: STP

1. Right click in the red column at the price you would like to places a sell STP

2. The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT

1. Leftclick in the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected

Modify Price/Quantity of an Order

Price of an Order

1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price

Orders
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@ ESZ6 - Depth of Market MmE[}]
| @ & |&fF v A4 M|  DEMozssso -
Qty: 1% Tatal PAL $ 66250
Pos: 0

| CancelBids || Cancelall || CancelOfiers |

1331.00

1330.75
1330.50
1330.25
133000
1329.75

........

1329.25
1329.00

B

Left Click: Modify Oty
Right Click: Cancel
Crag: Modify Price

| BuwMKT || Gotolast || selMKT |

Quantity of an Order
1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

i 3
= | [ & |&f ¢ (3G 0|  DEMozssaw - | &
15
by 1| Total PAL: $ BE2.50 14
13
2 N
Pos: 12
[ Canizel Bids ] [ Cancel Al ] [ Cancel Offers ] 1
10
:
| E 1| ?
I 133325
e 122200 [ Left Click: Maodify Gy
e 1332275 ER Right Click: Cancel
I 1332 50 e Drag: Modify Price
| 135225 [N BEN
| 13200 2
[ ] 133175 ISR 1
I 1350 EESHE
- -
| BuMKT || Gotolast || selMkT |

Thumbtack
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Stay on Top

Orders

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the

ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

¥ 6AZ6 - Depth of Market

-,

=%

A | [F & | Bf v (3 G |Gl | DEMO99993 -
Qty: 113 TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
7515
75.14
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelMkT

¥ 6AZ6 - Depth of Market

BEX]

@ || 3 & |&F v (3 & |4l | DEMo9gIgg -
Qty: 113 TatalPAL: $0.00
Pos: o
| CancelBids || Canceltnl |
r
75.15
7514
75.13
75.12
7511
-
| BuwMKT || Gotolast || SelMkT

Display Options

Auto Center Price

This Options keeps the MKT prices in the center of the viewable length of the DOM

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.
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Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-~

& DOM Setup
Dizplay | Mumber Pad | Font & Colors

Dizplay ltems

[] Auta Center Price [] OpenP/L

[ ] Open Orders Stats Open Pos Price

At Sum BiddAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad
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& DOM Setup x|

Configure the number pad

Setto Zern
1 2 3

4 al 10

15 | 20 | 50

Set to Defaults

[ k. H Cancel H Apply

Font & Colors
Allows Traders to change the DOM and the colors of the orders

OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

e  The option to restore the defaults is available if the color scheme does not work for the trader

& DOM Setup x|

Faont

AaBbvEz [ Change font ... ]

wiorking order colors
oco: |~ |
Stop: | I |~ |
TrailingStop: |_M

[] Save az Defaults [ Load Defaults ]

[ ] l[ Cancel ][ Apply ]
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Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

,m 6AZ6 - Depth of Market

[ setozen |R B4 [5F ¥ 3 & |4
Qty: 1% TotalPAL:

Pos: 2@7531| [Edtatt
[ CancelBids | [  Cancelasl |

Set to Defaults

il

75 34
Bl - | 7533

OCO Orders

Order Cancel Order (OCO)
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"o X
A | & 5 '*i’ 3 S [l | DEMO47094 -

Gty S5 Total PAL: $0.00 .
Foz 0 ¥ Confirm orders

:

a Buw 5 ESSR LMT 1324.50
Buw 5 ESSR LMT 1326.00

[ Mo

| v

i

=

10 132600 [N
B 1582 1323.75
2720 1325.580
| 2660 | 132525 [
4240 13265.00 -
N 132475 [
132450 E
Left Click: OCO LIMIT
| BuMKT || Gotolast || selmkT |
1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.
3.  To send OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.
4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).
5. Working OCO orders are displayed in blue color by default.
Order Flags
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BX]

L

# ESZ6 - Depth of Market

= | [ 5 - = |l | DEMO25830 -
Qty: 0/ Total P/ $1.000.00
Fos: 1]

[ 1324.00
1328.75
1328.50
1328.25
1328.00
2615 132778

1327 RN

S -

Order Flags

) Mone (O GTC O FOK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become

MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

e  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

e No order can be guaranteed an execution
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-,

@ ES76 - Depth of Market Mi==
= | [ 5 | ef "?’|i§} |l | DEMO47094 ~

Qty: 5% TatalPAL: $0.00

FPos: 0

r s

1326.75
1326.50
1326.25
1326.00
1325.75
1325.50
1325.25
1:325.00
1324.75

FEEO -

| BwMkT || Gotolast || selmkT |

[] Stop Limit [ ] Trailing Stop
Factor: Factor: 0.25 {3}

Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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ESZ6 - Depth of Market Mi==
| [F & | v (AlE ||l | DEMo47094 -
Qty: B TatalPAL $0.00
Fos: 0
- Offer
[ 1327 75 2327
e 1327 A0 2335
I 1327.25  [REEED
1327.00
122675
- 10062
| BuwMKT || Gotolast || SelmkT |
[] By Bracket [ ] Sell Bracket
[ ] Sell Limit [ ] Buy Stop
Factor: Factor:
[] 5ell Stop [ ] Buy Limit
Factor: Factor:

52

Buy Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.
Sell Bracket
1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing” an order with two opposite-side

orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.



P/L

ESZ6 - Depth of Market

L

B[]

1 | [ & |eF [¥ ] & |l | [oEmozsssn -
Ity D{:} Tatal PAL: CEMCZ5E30

DEMOE5399
Fos: ]

< Offer

1329.25
1329.00
132875
1328.50
132825

-

Goto Last

(PRI
jri=y
[P
] | )

Order Flags
) Mone (O GTC (3 FOE. () 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
- | [ & | sF v A G |l | DEMo47oa4 -
Qty: Sl Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1325.50
1325.2%5

-

| BwMkT || Gotolast || selmkT |

Open P/L or Current P/L

Orders
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@ ESZ6 - Depth of Market Mm=E[X]
=M | [F & |af v 245 |Hll|  DEMozssan -
Oy 04 | Total P/ $1.000.00
Pos: 0

-
I 1329.25 1766
1329.00

a7 1328.75

3883 1328.50
1 | 1328.25

w

Gioto Last

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

B[]

L

ESZ6 - Depth of Market

| [ & |Bf v (3 5 (| DEMO2S830 -
Qty: Bl&  Total P/ $ 81250
Fios: 5= 1323.50 [ Exit at MET ] [ Reverse ]
| CancelBids || Cancelal |
1348 132925 N
1124 12900 [
| 3661 | 122875 [
2621 1:2a50 (DD
3932 12625 [
| 4 | 132800 [
N 132775
1] 1327.50 [
132725
. 1327.00 [
] 12675
| 1| 132650 [N
1326, 25
-
| BwMkT || Gotolast || selmkT |
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

e
2| X

=4 | [ 5 "E’ 3 S [l | Demozss30 -
Qty: 5% TotalPAL $ 91250
Foz: 5132375 [ Exit at tET l [ Reverse ]
| CancelBids || Cancela |
[ 1330.00 3947
Bl - » 13297 1370
[ 1061 | 132950 (Fm o =
7459 1379 75 # Order Confirmation
: g;gi Egggg Account: DEMO 25830
4432 1328.50 Send SELL 5 ESZ6 MKT?
| 8 |
1328.25
N 1328.00
e Eg;;g | ok | | Cancel
I 172725
1327.00
-
| BwMkT || Gotolast || selmkT |

Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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J

(¢ X
=A | [F & |&f v (3 G |Gl | DEMO2S830 -
Qty: 1 Total P/ $ 725,00
Pos: 1@ 1329.75 [ Exit at MKT ] [ Feverse ]

id Y Cffer
IVl 17 b 132975
2749 1329.50 =
2105 1320 25 mﬂrder Confirmation
3475 1329.00
132850 8 Send SELL 2 ESZ6 MKT?
8 | 1328.25
[ 4 | 1328.00
N 132773 [ QK. ] [ Cancel
[ 1 | 1327.50
I 132725
I 132700 A
1326.75
w
| BuwMKT || Gotolast || selmkT |
Cancel orders
@ ESZ6 - Depth of Market M=}
M | (3 & |=f ¥ (A& ||  DEMO25830 -
Qty: 118 TotalPAL $ 697.50
Poz -1 @ 133025 [ Exit at MET ] [ Reverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Canicel Offers ]
Bid - Offer
I 133325 [
I 133200 [
I 13275 [HEE
I 133250 A
I 133228
I 133200 A
I 133175 [
e 1331.50 3160
I 1331.25 3327
v
| BwMKT || Gotolast || selmkT |
Cancel Bids
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market

# £576 - Depth of Market Mi==

= | [F & |EF v (A 4G || DEmMozssso -

Qty: 13 TotalPAL % £37.50

Foz: 1= 133025 [ Euit at MET ] [ Feverze ]

[ Cancel Bids ] [ Cancel Al ] [ Cancel Offers ]
- Offer
133325 [
1333.00 Il
133275
133250 [
133225 [
1332.00 [
1331.75 [
1331.50
1331.25 3327

w

| BuMKT || Gotolast || selMkT |

Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

Order Default

Can create default orders for each account which will appear when a new order is being placed after clicking on
NEW ORDER in the AOE.

a. Goto"Orders" >"Order Defaults..."
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b.

Enter your default parameters and hit "OK"

mﬂrder Defaults

Account: DEMO 25830 v
Drefault Order for

Buw/Sell Buy V

Symbol: ESLUE

OrderT ype: Market v

Flag: M one .v.

[ ] ] [ Cancel

Contract Setup

Every contract that appears in the "Selected" box will appear in your drop down lists for the order tickets and
guotes window setup.

Click on the desired group (i.e.) “Currencies” under the "Available" window and open it up so that you can see
all of the contracts included in that window. Click to add a checkmark next to the contracts you want to see in
your drop down lists for the order tickets and quotes window setup. You will see the contracts move to the
“Selected” box as you select them.

Once you have added the desired contracts to the contract setup “Selected” box you will next want to select
the months that you want to trade. If you change the month’s column to the “Nearest 2” selection you will most
likely have the contract months you trade. If the month you trade is not part of the Nearest 2 selection then
select “All Months”. Make sure that you click “Set Months” before exiting the “Contract Setup” window or else
your settings will not be saved.

You can also set a default quantity for one or many contracts at once by pressing CTRL and selecting the
contracts then, set the Def. Qty. and hit "Set Qty". Note: This settings will show once you log off and log back
in.
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# Contract Setup [Z]@
Available: Selected:
+ Curencies Description Sumbal | Manths -~
= Energies Auzzie Dollar B, Mearest
EH - Heating Ol Biritish Pound &R Mearest
CL - Crude 0l [pit] Cahadian Dallar BC Mearest
L - Crude Ol Euro Fx Currencies GE Nearest
GHO - Heating Dil Japanese Yen gl Mearest
Brazilian Real fL Mearest
GHU - Unleaded Mexican Peso =] Mearest
GNG - HH Natural Gas Mew Zealand D ollar BN Mearast
HH - Matural Gas Last-day Russian Fuble ER Mearest
HO - Heating Ol [pit) Swisz Franc g5 Mearest
HP - Matural Gas South African Rand B2 Mearest
HU - Unleaded [pit] Etkarol [pit) AC MNearest
NG - HH Matural Gas [pil] Auzzie Dollar [pit) AD Mearest
. Alurmninurn [pit] AL Mearest
[#] QG - HH Matural Gas it -
) . Heating Ol BH Mearest
LH - Heating _D'I !T"NY Sopbean Ol [pit] BO Mearest
[Ih - Crude Ol mitNy Biitish Pound [pit] EP Mearest
G - Gazoline miky Brazilian Real [pit] BR Mearest
RT - RBOB Gasoline Carn [pit) C Mearest
WS - Crude Oil Cocoa [|:-it]D o (1) Eg mearest
- : Canadian Dollar [pit earest
w| Fi I
= T Crude Oil it oL Nearest
rallns Catton Mo, 2 [pit] CT Mearest
¥ [] Indices DI [pi) 0 Nearest
- [v] Meats 15 Dallar D Mearast
+ Metals E-tini Euro Fi EV MNearest
+ Softg Ewro Fx Currencies [pit] EC Mearest
Euro Drallar [pit) ED Mearest
(‘I Ma. LIBOR [oit] EH MNearest = i

e Next, you will go to “Quotes” in the menu bar and select “Add Market” Select the contract you want to add and
click “OK”.

Confirmations

As a safeguard a trader can turn on the "Confirmations" feature in OECTrader. This gives the trader an opportunity to
confirm the order before the order is sent for execution. This feature is optional and is turned on by default.
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m OECTrader Demo

Order Confirmation

[ Cancel

— Account; DEMO 25820
O Send BUY 5 BAUG MET?

| oK

Notifications

File  Account | Orders | Communications  Quotes  Wiew  Reports  Setup Toolbox  t
Abbreviated Order Enkry Chrl+1
Symbal | HBo Turbo Crder Entry Chrl+2 Foz| ¢ Tatal PAL
BCUE Rapid Order Enkry Chrl+3 3 $250.00
ESLIE 10 $2. 625,00
Depth OF Market Order Entry Chrl+4
Crder Defaults. ..
.. v | After Submit
Ayerage Position Far ATter submi
Contrack Setup..,
Account | Confirmations 3 | Mew Order
DEMO25530 Natifications b [v] cancel order
Show Cancelled Orders
Show Rejected Orders
FA i [
Fa 1

If a trader wants to be notified by an alert box when an order has been filled or if an order modification or cancellation
failed leave the options checked. We recommend leaving a check mark next to “Notifications” > "Modify or Cancel

Failed".
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Orders

File  Account

Symbol | #Bo

ECLIE
ESLE

Ayerage Position

Account
DEMOZ25830

Orders | Communications  Quotes  Yiew  Reports Setup Toolbox  Help (
Abbreviated Order Entry Chrl+1
Turbo Order Entry Chrl+2 Pos| % Total PAL
Fapid Order Enkry Chrl+3 5 $300.00
10 $2.750.00
Depth OF Market Order Enkry Chrl+4
COrder Defaults. .
Clear After Subrmit
Conkrack Setup...
Confirmations ' Sumhnl Prire |_azt Crc

Matifications

v ] wewri

Show Cancelled Orders
Show Rejected Orders

Madify or Cancel Failed

m OECTrader Demo

-,

Cloze

J) A& fill [100231 238, 25] has been added into Order $733150

Show Orders

To display "Cancelled Orders" and/or "Rejected Orders" in the "Completed Orders" window check the options "Show
Cancelled Orders" and/or "Show Rejected Orders" respectively.

Account

DEMOZ5830
DEMOB5333
DEMOAB5333
DEMOZ25230

Order $#

770834
780529
¥83150
FE3258

State

Cancelled
Completed
Completed
Fejected

Side
Buy
Buy
Sell
By

ity
/3
20420
1040
000

Symbaol | Avg.Frice

ESUE
ESUG 1237.75
ESUG 1238.25
ECLIE
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Communications

Sound alerts

Customize different sound alerts to make you aware of trading events such as cancel failed, fill received, order
accepted etc.

You can customize with any wave (.wav) file or our programmed files which come with the software.
Decide if you would rather hear a sound or see an alert box.
To access Sound Alerts:

a. Communications > Sound Alerts

m Alert Settings

Channel Saund Level
Cancel Failed <default: Alert Bon
Desk Meszage <default: Sound
Fill Received <default: Alert Bow
M odify Failed <default: Alert Box
Order Accepted <default: Sound
Order Cancelled <default: Sound
Order Completed <default: Sound
Order Filled <default: Sound
Order |zzued <default: Sound
Order Rejected <default: Alert Bow

<default: v @

Level: | Alat Baox v

o) (o)

To configure:

a. Highlight the channel that you want to assign the sound to.

b.  Hit "Browse" and search your computer for (.wav) sound files. Note: The default windows .wav files are located:
(C:/WINDOWS/Media)

c. Hit"Play" to preview the selected sound.

d. Level: Set "Alert Box" if you want an alert pop-up along with the sound. Or, select "Sound" if you want sounds
only.

e. Hit"OK"

Message History
See your message history in detail of all previous chat sessions you have had with the brokers.

Click on "View" to view within the software or PDF to export into a PDF file or Excel to export into a .exe file.
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’ Message History
File
Begin Date: End Date:
08/23/2006 00:00 |+ | 08/23/2006 2359 |+ [ Wi ] [ FOF ] [ Excel ]
M 4 Paget1of1 bk M =]
Chat History for DFormica57
Time From -> To M
08/23/2006
15:28:33.607 DFormicas? -= Danield  |Hello T have a question.
15:28:47.170 DFormicas? -= Danield | What is the current symbol of th
15:29:13.512 Danield -= DFormicas? | The current symbaol for the mini ©
15:29:23.763 DFormicas? -= Danield | Thank you !
15:29:35.730 Danield -= DFormicas? | Your Welcome!
Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hello | have a question. | | Drarield
3:28:50 PM to DamelA\What iz the curent zumbol of the [

mini 5P 500 7

3:29:17 PM Danielh: The curent symbaol for the mini S&P

A00 iz ESUR -

D-30-3F Dhd b M amanl A - Tl - | J

In order to initiate chat with a BROKER, select their name (i.e. OECBroker9) and type your message in the open row
at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT button
and the broker you selected will receive your message. The drop box is there for your reference so you can repeat
your self with previous comments or say the same thing to a different broker by just clicking into the drop box and
selected the previously written text.

To access Chat:

a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
OEC population. It also displays Risk messages such as available credit, etc.

63



OECTraderUserGuide

Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rigk wiolation Max credit = 0 USD,Order would need credit of 6012.52
S0 [zash available iz 37862.48 1SD]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.
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Quotes

Add Market
To add a Market from Quotes window:

Right-click anywhere in the "Quotes" window and select "Add Market"
To add a Market from the main menu:

Main menu, go to "Quotes" > "Add Market"

The Market Selection box will appear. Just select the desired contract and hit "OK".

-,

m Market Selection

Contract Title: | BALIE [v]

[ ]9 H Cancel ]

Notes:
a. Add a market by contract
b.  Pit contracts are snap-shots

c.  Electronic contracts are streaming

Add Market Group
To add a Market from the Quotes window:

Right-click on the Quotes window and select "Add Market Group".
To add a Market from the Main menu:

Go to "Quotes" > "Add Market Group".

The "Market Group Selection" box will appear. Select the market group and the nearest month or all months.

rm Market Group Selection W
Group Title: b onths:
|Eurrencies [VI |Nearest1 [VI

[ OF. ] [ Cancel ]

Remove Market

Remove the highlighted market from the Quotes window.

Quotes
Symbol Add Market Bid...
ESUG Add Market Group 11
6AUG | Remove Market | 109
6CU6 r 14
FDAXU6 Re iRemnve Market ] 14

1. To remove a Market:
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a. Highlight the market in the Quotes window

b.  Right-click within the Quotes window and select "Remove Market"

2. Toremove a Market
a. Highlight the market in the Quotes window

b. Main menu "Quotes" > "Remove Market"

Remove All Markets

Remove all markets from quote window.

Quotes
Symbol La fdd Market
ESUG 1305.1 fdd Market Group
6AUG 75.¢ Remove Market
GCLIG 9.1
FDAX‘JE 53?4 | Remaove Al Markets |
GEL'G 128.( e
& omae o rdRemove Al Markets

1. To remove all Markets:

a. Right-click anywhere in the Quotes window and select "Remove All Markets"

2. To remove all Markets:

a. Main menu "Quotes" > "Remove All Markest"

Insert Blank Line

Insert blank line just above the highlighted contract in the Quotes window.

1. Toinsert a blank line:

a. Highlight the contract that you want to have the blank line insert just above

b.  Right-click and select "Insert Blank Line"

2. Toinsert a blank line:
a. Highlight the contract that you want to have the blank line insert just above

b. Main menu "Quotes" > "Insert Blank Line"

Quotes
Symbol #dd Market id
ESUG &dd Market Group A1)
6A LG Remaove Market 89
6CUIG 07
FDAXU6 Remove All Markets .5
Insert Blank Line
GELIG
Bl o et |

Move up/Move Down

Move the highlighted contract up/down.

To move a contract up/down:

a. Highlight the contract in the Quotes window
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b.  Right-click and select "Move Up" or "Move Down"

Sort by Alpha

Sort all the contracts in the Quotes window in alphabetic order.

To sort by alphabetic order:

Quotes

a. Right-click anywhere in the Quotes window and select "Sort by Alpha"

Custom Price Fo

rmat

Allows customers to change the decimal format of LAST, BID and ASK columns within the Quotes window.

-,

m Price Format
BSLIE
Default Format Drefault Multiplier
w2 * 000000
wid * 000001
w8 *0.0001
w16 *0.00
wiaz 00
w4 01
w128 “1
/256 10
0 *100
nao *1000
Q.00 *10000
0.oon *100000
0.0000 * 1000000
0.00000
0.000000
0.0000000
0.00000000
0.000000000
Apply ] [ Cancel
Font

Customize the font of your Quotes window.
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-~ =~
Font
Eont: Faont ztyle: Sizer
Microzoft Sang Serf Reaqular g [ K ]
)} Microsoft Sans Serf [~ | |Fegular a ”
{} Monotype Corsiva [ ] [talic 9 E
(} W5 Outlook Biold 10 3
{} M5 Reference Sans 5| | Bold ltalic i
(} M5 Reference Specia 12
(} MV Bol 14
{} Palating Linotype [V] 16 [v]
Effectz Sample
[ Strikeaut
AaBby
[ ] Underline sBbYyZe
Scrpt:
|Westem [V]
Rename...

Ability to rename the title of the Quotes window.

Go to "Quotes" > "Rename...", enter the title name and hit "OK".
Fa -1

Custom name of Quote...

Pleaze enter new name:;

[uotes Test

k. ] [ Cancel

The renamed Quotes window title would look like the one below.

Quotes Test

Symbol Last| LastVol Bid | BidSize
ESUG 1297.75 10 1297.50 528
6AUG 76.76 4 76.76 7
6CLIG 90.11 1 90.11 17
BELIG 127.81 3 127.81 22
6JU6 5.674 1 8.673 240
656G §09.3 6 809.1 21

Add,Remove Price Alert

To add an alert, select the desired contract from the Quotes window. Select "Add Price Alert" to get to the
below window. Enter Alert Price, criteria and the options text.



m OECTrader Demo

Alert Price  1238.00 % (®) <=
0=
) Auto

Alert Test [optional]
ESUE went below or egual to 1298.00

1] l [ Cancel ]

When the price criteria is met, the alert box is displayed.

-,

m OECTrader Demo

1 ESUE went below or equal to 1233.00
iy

Quotes

To remove an alert, select the desired contract from Quotes window. Right click and select "Remove Price

Alert".

View Price Alerts...

Go to "Quotes" > "View Price Alerts".

To remove one alert, select one alert and hit "Remove”. To remove all alerts, just hit "Remove All".

m Price Alerts

w

Market | Frice IJzer Meszage
ESLE ¢=1298.00 ESUE went below or equal to 1293.00

Edit Femove Fiemove All

Depth or Market (DOM)

Opens the DOM for a specific contract. Jut highlight a contract from the Quotes window then select "DOM".
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Quotes Test Add Price alert

Symbol 4
ESUG 1 |
GALG

GCLIG Do |
FDAXUG chart

6EUG ar

616 Colurnn Sekup.. .

gf:;ﬁ Export ko 25V,

Next, the DOM window will open.

'@ ESUG - Depth of Market mEx]

= | @ & |eF v (3 5 |l | DEMo2ss30 -
Qty: 0% TatalPAL: $2,125.00
Pos: 10 123300 [ Exit at MET ] [ Feverse ]

F 9
I 1257 50
1297.25
184 | 1257.00
1295.75
1557 129550
-

3o ko Last

Column Setup

Check the columns that you want visible from the Quotes window. Then, hit "Save" to view your the changes.
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m Quotes Test

Symbaol ~
Last

Laztval

Bid

BidSize

Iz

AgkSize

High

Loy

Chg

Chaoi
Tatakal
Open

Settle

[] Updated

[] Baze Contract
[] Expires

[] Description

[ Cumrency [v]

Cirag a column by mouze or Presz Chl-lp or
Ctil-Drava ko change the column order

Save l [ Cancel

Export to CSV

Quotes

Exports your Quotes window data to an excel file. After selecting this option you will see a confirmation dialog

box.

To export all items just hit "Yes".

To export selected items, you would have to first highlight the desired items from the Quotes window by
pressing CTRL left mouse click each item. Then, select the "Export to CSV..." option and hit "No" in the

confirmation dialog box.

~

Export

-,

Do wou wankt export all ikemsy
i'fes - all items, Mo - selected item only)

o oves [ Mo ] [ Cancel

)
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View

Lock/Unlock Windows

Wiewd | Reports  Setup Toolbox  Help

» | Lock Windows ”_

] showTabs Total P/L
Lawout p | -B.250.00 USD

To lock OECTrader windows:
a. Main menu, click on "View" > "Lock Windows".

b.  When a check is next to "Lock Windows" then the windows will stay in the current location and are not
configurable.

To unlock OECTrader windows:
a. Main menu, click on "View" > "Lock Windows" and make sure that there isn't a check next to "Lock Windows"

b.  Uncheck "Lock Windows" then the windows will become movable and configurable.

Show Tabs

Some of the windows within OECTrader have tabs available which can be displayed by selecting View > Show Tabs.
The tabs will appear below the box they are associated with

Example 1: Positions window has "Average Positions" and "Detailed Positions"

Symbol | Awg Buy Price | Awg. Sell Pice | Amount | Realized PAL

ECLIE 30.04 0.00 5 noouso
ESUE 1233.00 0.00 10 0.aoauso

Avwerage Pozitionz | Detailed Positions

Example 2: Order Tickets window has "Standard", "Turbo", 'Rapid", "DOM".
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Abbreviated Order Enry
Side hdarket Selection
() Buy Cuartity Symbiol
O Sel 1] K4 EALE
Order Specs
Type: | Market v Flag: | Maone

| BLMT F3 | | B-MKT F4 |

Mew Order F8 | | S-LMT F5 | | 5-MKT Fg |

Standard | Twbo | Fapid | DOM

Layout

Layout

View

Template:; v

Layout offers the ability to save different window configurations and delete existing configurations.

Layout also allows the trader to RESTORE DEFAULT LAYOUT; which is the initial layout that appeared when the

software was first downloaded.

Save...

Save an already customized layout. Enter a name for the layout and hit "OK".

-,

Save Layout

Enter name af layout;

Mullayout]

l OF. ] [ Cancel

Once the layout is saved it will be available under View > Layouts.
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Wiews | Reports  Setup Toolbox  Help Open a Live Account
Lock Windows |
Show Tabs |
| Layout [ Save..,
Positions 3 Delete. ..
Account Summary Restore Default Lasyout
Cpen Orders MyLayoutl
Completed Orders
Crder Tickets 3
Quates Account Order #
1 DEMOE5399 7Fa0529
Depth of Market r — DEMOBE339 Fa3180
harts , i DEMOZ5830 Fa3258
DEMOE5339 Faa704
Cornrnunic ations » ;
Delete...

Delete a saved layout. Select the layout that you want to delete and hit "OK".

Configuring Windows

Docked Windows

To configure that specific window, right-click on any of the boxes to view a menu as the one below.

View information on how to unlock a window.

Account Summary =
Close E
Profit/Loss Undock,
EPEF PQLP,-'L Configure. ..
ealize
Tatal PAL Show Tool Bar
Balance Top Header
Netliq Left Header |
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).

Undock

The DOCKED form is the form that appears on the default layout. Each box its nicely compacted within
the width and height of the OECTrader platform. Any undocked boxes will appear as free flowing
windows. The UNDOCK feature will remove the selected box from the docked form and display the

selected box as a free flowing window.

If a free flowing undocked box is open, when the OECTrader platform is closed/minimized the free flowing

box will close/minimize with it.




View

Live Account Account: DEMOZSE30

Account Summary D %]
TI:ItEIl ---------
Profit{Loss
Open PAL $3.175.00 Exit Al
Realized P/L F$0.00
Tatal P/L $3.175.00
Balance I
Met Lig £ 4286250
]
Configure...

See Information.
Show Tool Bar

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Top Header

Display the header on the top of the box running from left to right the entire height of the box.
Left Header

Display the header on the left-side of the box running from top to bottom the entire height of the box.

Undocked Windows

Once the windows are unlocked the ability to change the windows are endless. Perform a mouse right-click on
the header of the undocked window to view a menu like the one shown below.

View information on how to lock/unlock windows.

Account Summary sl
Profit/Lozs Move
Open FAL %35 Size
Realized F/L i
Tatal PAL %36
O Maximize
Balance |
Met Lig 4493 X Close Alt+F4
Configure. .. 1
Show Toolbars
v Dockable
Independent
Skay On Top
Move

Allow to move the box without activating the blue docking indicator arrows.

Size

Allow to change the size of the box. Same result is obtained by carefully hovering the mouse on one of
the borders of the box until the mouse cursor changes to a double-pointed arrow, at this point you would
want to left-press your mouse and drag until the desired size is achieved.

Maximize
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Maximize the window to the whole size of your screen.
Close

CLOSE will remove the selected box from the layout. This allows traders to configure the trading platform
layout. If you wish to re-open that box just simply go to "View" > and the box you wish to open. Once
clicked the box will appear UNDOCKED and you will have to manually dock into the Layout (if desired).
Configure...

See Information.
Show Tool Bars

If the check is next to the "Show Tool Bar", the tool bar will appear within that box. The tool bar offers a
number of different options depending on the box selected. Each box has different toolbar options.
Dockable

When 'Dockable’ is checked, dragging the undocked window will show the the layout configuration tool
(blue indicator arrows) which allow to dock the window.

Independent

When ‘'Independent' is checked, the undocked window will change its look to that of a regular window.
Stay on Top

When 'Stay on Top' is checked, the window will remain visible at all times; it will never be under any other
window on your screen.

Docking a Window

1 Live Accounk Account: DEMOZSE30
Account Summary |:| x|
TDtEIl .........
Profit{Loss
Open PAL $3.175.00 Exit Al
Realized P/L F$0.00
Tatal P/L $3.175.00
Balance I
Met Lig £ 4286250
]

Perform a Left-click and leave pressed the header section of the window. Drag the window slowly onto the
box you desire to place it, you should see the layout configuration tool (blue indicator arrows) shown in the
below image.



View

wen PYL —al FAL ||
uouso 1,]L|SD Tatal
b IS
L M 3 s Profit/Loss
4 b Open PAL $ 2.650.00
Fealized P/L $0.00
Tatal AL $ 3.650.00
Balance
g Met Lig $49,337.50
d Account | Or

Keep pressing the header of you window, place your cursor over the location in relation to the box that is
highlighted. In this case we select the single right options in the layout configuration tool to dock the
Account Summary window in its original spot. Or, If you want it to stretch across the bottom place your
cursor on the bottom option of the layout configuration tool.

Configure

To configure a window, first make sure that the trader windows are unlocked. View information on how to
unlock a window.

Account Summary sl
Profit/Lozs Move
Open FAL %35 Size
Realized P/L i
Tatal PAL %36
Mazximize
Balance
Met Lig 4493 X Close Alt+F4
Configure. .. 1
r Show Toolbars
v Dockable
Independent
Skay On Top

Then, place the mouse on the header of the window, perform a right click and select 'Configure...".

CONFIGURE allows traders to open the specific options for the selected box. Whether it be toolbar
options, menu options or general box settings.
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Account Summary D

Toolbars « Menu = Settings -

Default

All Currencies
Setup
Special

Separator

Toolbar
Gives the options to have one or multiple toolbars with various tools within each toolbar. At any time
a trade can restore the toolbar to the default layout.

Menu
Offers options to add different utilities into the menu option for each box.

Settings
Provides the ability to change the types of methods traders wish to use the toobar.

Positions

Average positions
Displays the average positions open on each specific contract that has been traded.
In order to go flat in a specific contract:

a. Inorder to go flat in a specific contract, left click on the position and click on EXIT F2. This will immediately
transmit a market order for the contract selected to flatten the position.

b. Inorder to go flat all current contracts with open positions left click the Exit All. This function will immediately
transmit a market order to exit all contracts with open positions.

Symbal | HBought | Awag. Buy Price | #Sald | Awag. Sell Price | Met Pos % Total PAL

ECLIE 0 0.00 5 90.03 ] SE0.00 | Exit All
ESUE 20 1293.75 0 0.00 20 $£260.00

Detailed position

Shows each contract that has been traded specifically. Exit or Exit All the same way as the Average Position window.
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4| ¥
Symbal | Awg. Buy Price | Awg. Sell Price | Amount Realized F/L Open P/L Total F/L
BCLE 0,00 a0.03 -5 0,00 USD 10,00 0sD 000 LS | Exit Al
ESUE 1293.75 Q.00 20 0.00 LS 280,00 USD 28000050

Account Summary

You can customize the "Account Summary" window by hiding the rows that you do not want to see.

Account Summan [
Total
Profit{Loss
QOpen PAL $0.00
Realized P/L $13.875.00
Total PAL $£13,875.00
Balance
Cash % B4.765.00
Open PAL 0.0o
Met Lig % B4,765.00
Fate

Right-click anywhere inside the Account Summary window then, select "Column Setup..."

Account Summan [
Total
Profit{Loss
Open PAL $0.00
Realized P/L $13,875.00
Tatal PAL $13.875.00
Balance
Cash % B4.765.00
Open PAL 0.0o
Met Lig % B4,765.00
Fate

Al Currencies

| Column Setup...

Fonk...

Click on the row that you want to hide under the column "Visibility" and select “hidden”.
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.
m Account Summary

B[]

Colurmn Wigibility
Open PAL Hidden w
Realized P/L ==
Total P/L Eg‘l’dma'
Cash Hidden
Open PAL TTarmal
Met Lig t armal
Fate Marmal
()4 l [ Cancel

Realized P/L shows the P/L of any closed trades.
Open P/L shows the P/L of any open positions.
Total P/L shows the total P/L for both the Open and Realized P/L.

Account Summan

Tatal 5D
Profit/Lozs

Open P/L $0.00 0.00
Fealized F/L -5 9500 -595.00
Tatal PAL -5 9500 -55.00

» | all Currencies
A0,167.50
Colurmn SEtLF:"E .00

UrFEnCies
Expark bo C34, ., | 501 E?.51EI
4 Fant. .. -

CHF

0.00
0.00
0.00

0039
0.00
003

7673

If you have a balance in another currency you will see another window showing the same information for that
currency. The window titled “Total” will sum up all the currencies in your account so if you want to view this window
only, uncheck “Show Currency Summary Columns”.

Open Orders

Open Orders

Account Ord... State

DEMOBS393 818452 ‘Working
DEMOBS333 818508 “Working

Ayvg. Side | Oty | Sumbal
Bupy 040 ESUE
Sell 0/2 wWlB

Frice Lazt. Crnd
LT 1303.75  #426574 Cancel all
LMT 40000 by DemoBroker #426581

i Find

Open Orders allows traders to view their open orders in addition to the order statisitics. At any time a trade can
cancel the order by clicking “ Cancel” which will cancel the selected order or “Cencel All” which will cancel all the

orders in the Open order box.

Completed Orders



View

Aooount Order #| State Side [ty | Symbal Ay Price
DEMOER339 a18481 Completed By 10410 ESUB 1307.00
DEMOEE339 2818530 Completed Buy 20420 BELE 12849
DEMOBR399 2818533 Completed Sell 5/5 BELB 12850

Completed Orders provides traders with an accurate view of their completed trades from the current session. The
completed orders is color coordinated for easy viewing and customization. Traders can customize anything from the
column setup to the font size by right clicking in the completed orders box area

Order Tickets

Abbreviated Order Entry (AOE)

Simple way to trade within the platform.

<[

Side kdarket Selection
(&) Buy Guiaritity Symbiol

1] ESUE
0 4 - -
Order Specs
Type: | Market " Flag: | Mone w

| BLMT F3 | [ B-MKT F4 | Template: v
New Order F8 | | S-LMT F5 | | 5-MKT FE |

Side
Buy
Purchase a certain commodity at a certain date in the future at a pre-set price. The future date is called the
delivery date. The pre-set price is called the futures price. The price of the commodity on the delivery date is

called the settlement price. The futures price, naturally, converges towards the settlement price on the delivery
date.

Sell

Sell a certain commodity...
Market Selection

Quantity

Amount of contracts you desire to trade.

Symbol
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Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade
futures contracts

Order Specs

Type

Market (MKT)

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at
any given price, and are used to enter or exit the market quickly, regardless of the current price.
Limit (LMT)

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has
been reached, i.e., they do not become MKT orders.
Stop (STP)

Orders are traded only when the MKT price trades at or “through” the STP price.

a. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when
the futures price trades or is bid at or above the STP price

b.  Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the stop price
Stop Limit (STP LMT)

Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached. No order can be guaranteed an execution.

a. Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit level

b. Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the
order will not be filled unless the price remains at or rises above the limit level
Market If Touched (MIT)

Similar to STP orders in two ways:

1. They are activated when the price reaches the order level
2. They become MKT orders once they are activated

MIT orders are used differently from STPs.

Buy MIT below the MKT price to establish a long position.

Sell MIT above the MKT price to establish a long position.

MIT orders are not allowed on CBOT but are used on CME.
Market To Limit (MKT2LMT)

Market On Open (MOO)

A buy or sell order in which the broker is to execute the order at the market's opening. It does not
guarantee the trade will be executed at the listed opening price, but the trade will be executed within a
range of prices, or not at all.

Market On Close (MOC)

A buy or sell order which is to be executed as a market order as close as possible to the end of the day.
Market On Pit Open (MOOPIt)

This order type is similar to the MOO however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOOPIt if traders want the contract to be traded at the opening of the
Pit for the corresponding pit contracts opening.

i.e. ES has a next day opening of 4:30 EST but if a trader places a MOOPIt type then the order will be
placed when the S&P opens at 9:30 am EST
Market On Pit Close (MOCPiIt)

This order type is similar to the MOC however it only applies to electronic contracts that have
corresponding pit contracts.

Electronic contracts can be placed MOCPIt if traders want the contract to be traded at the closing of the Pit
for the corresponding pit contracts close.
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Trailing Stop Loss (TrSTP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market
price. If the market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop
loss price doesn't change. This technique allows an investor to set a limit on the maximum possible loss
without setting a limit on the maximum possible gain, and without requiring paying attention to the
investment on an ongoing basis.

Trailing Stop Limit (TrSTP LMT)

Place a TrSTP which is a complex stop-limit order in which the stop limit price is set at some fixed
percentage above or below the market price. If the market price falls or rises, the stop loss price fall or rise
proportionately, but if the stock price rises or falls, the stop limit price doesn't change. This technique
allows an investor to set a limit on the maximum possible loss without setting a limit on the maximum
possible gain, and without requiring paying attention to the investment on an ongoing basis.

Once the TrSTP has been activated at or above/below depending on the SIDE the commodity was traded;
the order will not be filled unless the price remains at or drops/rises in relation to the LMT level.

Flag

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten
Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled
Immediate or Cancel (IOC)

LMT orders which, if not filled immediately, are cancelled
AON

Hot Keys

Template

Have the ability to create a template for quick and easy trading of specific contracts

Save/Delete.

a.

i.e., BUY the ES at 5 QTY with MKT type and GTC flags. Click on save and when this template is
referenced to it will ALWAYS appear as above: BUY 5 ES MKT GTC

Traders can have as many Templates as desired for quick an easy trading made for the trader.
You can have different template for the same contract.

DELETE refers to the template that is highlighted in the REMOVE TEMPLATE drop box. This feature is
nice if you have increased your volume and desire to revise your old template.

Transmit/New Order

Exit MKT

a.

In order to EXIT (F2) a Position quickly, traders are able to highlight the position they wish to exit, and
select EXIT or hotkey (F2).

Once EXIT has been activated the AOE box will display the exiting trade for that position in order to make
it FLAT. Click on Transmit and the exiting trade will be placed.

Trade Contract

a.
b.

Place a trade by clicking TRANSMIT

Remove the current order information for a new trade by clicking NEW ORDER.

Turbo Order Entry (TOE)

a. Create a number of orders at one time

b.  Can transmit multiple orders concurrently
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c. Allows you to load and save orders from excel.

Turbo Order Entry 4] »
Account Side [ty | Symbal | Type Flags Price | Price? | Statuz

[+] DEMOZ2E830 Buy 4 BALG M ark.et Maone Ready to zend
DEMOZEE20 Sell 15 ESUB Lirnit GTC 1.50 Ready to zend
DEMO2EE30 By 4 EELEG M arket MHone Feady to send
DEMOZ5530 By 15 EDUG b arket Mone R eady to send

£ pJ

Mew Order Transmit E-LMT B-MKT S-LMT S-MKT | Submit Al Delste Clear | (2% Load 5

Side

Buy/Sell a certain commodity at a certain date in the future at a pre-set price. The future date is called the delivery
date. The pre-set price is called the futures price. The price of the commodity on the delivery date is called the
settlement price. The futures price, naturally, converges towards the settlement price on the delivery date.

Qty

Amount of contracts you desire to trade.

Symbol

A future symbol is a code by which futures are identified on a futures exchange; a corporation which provides the
facilities to trade futures contracts

Type

MKT

Orders to buy/sell at the best possible price as soon as possible. They are the first orders to be filled at any
given price, and are used to enter or exit the market quickly, regardless of the current price.

LMT

Orders generally used to buy/sell at a specified price, or better. They don’t move once the limit price has been
reached, i.e., they do not become MKT orders

STP

a. Orders are traded only when the MKT price trades at or “through” the STP price

b. Buy STP orders is placed above the current MKT price and is transformed into a MKT order when the
futures price trades or is bid at or above the STP price

c. Sell STP order is placed below the current MKT price, and is transformed into a MKT order when the
futures price is traded or is offered at or below the STP price

Price
The factor at which you want the order to be placed in regards to the current price. i.e., ES MKT price is 1299.5;

PRICE will be placed 1.5 ticks above/below that current price . The Price will be placed above or below the MKT
price depending on the SIDE you trade on.
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Price2

PRICE 2 is only used if two prices are necessary for a trade. i.e., If a customer were to BUY 5 ES STP LMT PRICE
would be 1.5 ticks above the MKT and .5 Ticks below the PRICE once the STP has been reached

Status
1. Confirms what key pieces of information are needed in order to complete an accurate trade

2. Will say READY TO SEND if the order ticket has been completed
Toolbar/Hot Key

Transmit/new order
a. Place atrade by clicking TRANSMIT
b.  Remove the current order information for a new trade by clicking NEW ORDER.

Submit All

Enter a variety of trades manually or load from excel and place all the orders at the same time

Delete/clear
a. DELETE will remove the highlighted order entry
b. CLEAR will remove ALL order entries

Load/Save
a. Load from .csv files or from .exe file types.

b.  Save the order entries to .csv files or .exe file types

Rapid Order Entry (ROE)
Advanced method to trade with specific amounts and settings.

R apid Order Entry ]
At Factor Settings

w

Bup StopLimt 0.00 4] (000 [2 Stop| 129575 (4] Limit 129575 (&
Sell Limit 000 3 Limit | 1295.75 |3 Sell Limit
[uiantity Symbal
0 | [ESUE v Last 1295.75
- . Size -

Bid 129550 | . Sell Bid
Auto Factor Settings
B Limit 000 3 Limit |1295.75 |2
SellStop Limt 0.00 (2] (000 3] Stop129675 2| Limit129575 3

Auto Factor Settings

Buy Stop Limit
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e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

®  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order
will not be filled unless the price remains at or drops below the limit leve

e  No order can be guaranteed an execution
Factors

The values that you wish to increase your STP order by, i.e., .50 in the first box will increase the STP value
by the factor of .50; The same concept works the second factor box in that it effects the LMT.
BUY STOP

Places the STP LMT prices for the buy STP LMT order
Stop
Buy STP orders is placed above the current MKT price, but is not transformed into a MKT order when
the futures price trades or is bid at or above the STP price; It turns into a LMT order

Limit
LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

Sell Limit
Factors

The price at which you want to place the Sell LMT
SELL LIMIT

Limit
1. Alimit order is an order to buy or sell a commodity at a specific price

2. Can only be executed at the limit price or higher
Market Selection

Quantity

Amount of contracts you desire to trade for the entire ROE

Symbol

e A future symbol is a code by which futures are identified on a futures exchange; a corporation which
provides the facilities to trade futures contracts

° Is the contract that is traded for the entire ROE

BUY ASK/SELL ASK
BUY ASK

Bid on a commodity at the ASK price
SELL ASK

Sell a commodity at the ASK price
Ask

The ASK price (Offer). The lowest price at which someone is prepared to sell a commodity
Size

The number of sellers at the ask price
BUY MARKET/SELL MARKET

° Will buy a contract of the ROE’s QTY at the MKT price of the ROE’s symbol or

. Will sell a contract of the ROE’s QTY at the MKT price of the ROE’s symbol.
Last

The price at which the ROE’s symbol was last traded
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BUY BID/SELL BID
BUY BID

Bid on a commodity at the BID price
SELL BID

Sell a commodity at the BID price

Bid

Bid Price is the highest price at which someone is prepared to buy a commodity
Size
The number of buyers at the bid price

Auto Factor Settings

Buy Limit
Factors

The value that effects where the LMT order will be placed, i.e., 1.5 will place a LMT 1.5 below the LAST
price
BUY LIMIT

Limit: LMT order is placed used to buy/sell at the specified price. It doesn’t move once it has been
reached, i.e., it does not become MKT order.

Sell Stop Limit

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not
become MKT orders once the STP price has been reached

e  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order
will not be filled unless the price remains at or rises above the limit level.

e No order can be guaranteed an execution
Factors

e  The values that you wish to decrease your STP order by, i.e., .50 in the first box will decrease the
STP value by the factor of .50;

e  The same concept works the second factor box in that it effects the LMT
SELL STOP

Places the STP LMT prices for the sell STP LMT order
Stop

e  Sell STP order is placed below the current MKT price, but is not transformed into a MKT order
when the futures price is traded or is offered at or below the STP price; turns into a LMT order.

Limit
e LMT order is used to buy/sell at the specified price. It doesn’t move once it has been reached,
i.e., it does not become MKT order

e  Can only be executed at the limit price or higher.
Depth of Market Order Entry (DOM)

Depth of Market Order Entry (DOM)

To view the Depth of Market Order Entry go to "Orders" > "Depth Of Market Order Entry"

Open
To open a DOM window from the Depth Of Market Order Entry:

Select the contract symbol from the drop down then hit "Launch".
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Depth 0f Market Order Entry )
Symbol: |BAUE  |v| [Launch | Symbol Launch
Symbok | |%| Leauech | Swmbok | [ Leurck
Symbok | |%| Leunch | Swmbek | [s]| Lewrch
Symbok | %] Lawnch | Spmbok | [s] Laween
Symbok | [w| | Launch | Spmbok | || | Lawnck
View

To open a new DOM, go to "View" > "Depth of Market" > "New..."

Wigw | Reports  Setup  Toolbox  Help Qpen &

Lock wWindows

Show Tabs Tatal P/L
Layout y | -250.00USD
Positions »

Account Surnmary

Open Orders

Completed Orders

Order Tickets 3

Cuotes

Depth of Market 3 m Blew., ..

Charts k ESLIG

Communications GELIE
E7LS

e  The only contracts that will appear in the drop box are those that have been specified in the "Contract
Setup..." under Orders

e  Select the account and contract you wish to trade the DOM and hit "OK".
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rm DOM W
Accaount; | DEMOE5339 M
Contract: | ESLIE M

[ Ok, H Cancel l

To open a DOM session, go to "View" > "Depth of Market" > i.e:" ESU6".

contracts you have opened before or are on the default layout.

Wiewd | Reports  Setup Toolbox  Help Cpen &
Lok Wwindows
Shows Tabs Tatal PAL
Layauk » 0.00UsD
Positions »
Account Summmary
Cpen Orders
Completed Orders
Order Tickets 3
Quokes
Cepth of Market 3 | Mew, .,
Charts 3 | Eelle
Communications GELE
E7LG
Quotes

View

Contracts below the brake Line are

Right-click on the contract within QUOTES and scroll down to DOM, click on it and a DOM will appear for the

quote you have highlighted.

Quotes Test Add Price alert
Symbol

ESUG 1

GALG

6CLIG DOM
FDAXUG chart

6EUG ar

6.6 Column Setup. .
gf:;ﬁ Export ko 25V,

89



OECTraderUserGuide

DOM - Opening

Quotes box

Right-click on the contract within Quotes window and select "DOM" in the submenu and a DOM will appear for the
quote you have highlighted.

Quotes Test Add Price alert
Symbol 4
ESUG 1 |
GALG
GCLIG Do |
FDAXUG hart
ﬁE‘Jﬁ 3
616 Colurnn Sekup.. .
gf:;ﬁ Export ko 25V,

View

Contracts below the brake line are contracts you have opened or are on the default layout. Select any one of these
contracts to open the respective DOM.

Yiew | Reports  Setup Toolbox  Help Qpen ¢

Lock Windows
Shiov Tabs Total PAL

Lavout . 0.00 USD

Positions »
Account Summary

Open Crders

Completed Orders

Order Tickets 2

Quokes

Depth of Market 3 | Mew, ..

Charts » | -

Communications SELE
E7LG

Depth of Market Order Entry

Main menu "Orders" > "Depth of Market Order Entry"

Charts

Open chart a of the DOM contract you have open currently.
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¥ ESU6 - Depth of Market

DEEX)

N e A A =

Open
ICha
(il rDEMOSSSBQ -

ity 1004 Total PAL:

m -§ 3,000,000

FPos:

20 (= 1305.00 [ Exit at KT ] [ Reverse ]

r s

1303.00
130275
130250
130225
1302.00

-

[ By MET ] [ Goto Last

|| selmkr |

Bid
'@ 6AZ6 - Depth of Market M=)
| [ |aF v (A5 |l | DEMO9gess -
Oty 1% Tatal PAL $0.00
Pos: 0

| CancelBids || Cancelan |

- Offer
5

75.28
Left Click: LIMIT [ps5.27
Right Click: STOP EE.EE

75.25
=
| BuwMKT || Gotolast || selMkT

Right Click: STP

1. Rightclick in the green column at the price level you would like to place a buy STPLMT

2. The QTY of the buy STP will appear in the white column next to the price level selected

Left Click: LMT

1. Leftclick in the green column at the price you would like to place a buy LMT

2. the QTY of the working order will appear in the white column to the left of the selected price

View
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Offer .
¥ 6A76 - Depth of Market M=

=R | [ 5 |efF ¢ 3 (| DEMOZ9sss -
Oty 1% Tatal PAL $10.00
Pos: 1@7529) | Exit atMKT | | Reverse |
| CancelBids || Cancelall || CancelOffers |

Left Click: LIMIT
Right Click: STOP

[ Buy MET ] [ o to Last ]

Right Click: STP
1. Right click in the red column at the price you would like to places a sell STP

2. The QTY of the working order will appear in the white column to the right of the price selected

Left Click: LMT
1. Leftclick in the red column at the price you would like to place a sell LMT

2. The qty of the working order will appear white column to the right of the price selected
Modify Price/Quantity of an Order

Price of an Order

1. Place the initial order by left clicking in the green column at the price you would like to place a buy limit

2. To modify the price left click the order and drag and drop it to the new price
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# ESZ6 - Depth of Market

-,

=/

| [F & | af v (345 |l | DEMO2S830 -
Qty: 1% Tatal PAL $ 66250
Poz: N

[ Cancel Bids H Cancel Al H Cancel Offers ]

Bid

........

Left Click: Modify Oty
Right Click: Cancel
Crag: Modify Price

F

1331.00
1330.75
1330.50
1330.25
1:330.00
1328.75

1329.25
1329.00

B

| BuwMkT || G

to Last

J

Sel MKT |

Quantity of an Order

1. Place the initial order by i.e., left clicking in the red column at the price you would like to place a sell LMT

2. To modify the QTY left click the original order and select a new QTY from the pop out box

i 3
= | [ & |&f ¢ (3G 0|  DEMozssaw - | &
15
by 1| Total PAL: $ BE2.50 14
13
Paos: 0 12
[ Canizel Bids ] [ Cancel Al ] [ Cancel Offers ] 1
10
:
| E 1| ?
I 133325
e 122200 [ Left Click: Maodify Gy
e 1332275 ER Right Click: Cancel
I 1332 50 e Drag: Modify Price
] 135225 [N BEN
] 13200 I 2
[ ] 133175 ISR 1
I 1350 EESHE
- -
| BuMKT || Gotolast || selMkT |
Thumbtack

View
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Stay on Top

To make the DOM ticket stay on top of other applications left click on the Thumbtack so it is pointing straight into the
ticket. To allow the DOM to move behind other applications left click the thumb tack again so it is sideways

When the Thumbtack is pointed out to the left this means the STAY ON TOP feature is not active.

-,

=%

¥ 6AZ6 - Depth of Market

A | [F & | Bf v (3 G |Gl | DEMO99993 -
Qty: 113 TatalPAL: $0.00
Pos: 0
| CancelBids || Cancelal |
r
7515
75.14
75.13
75.12
7511
-
| BwMKT || Gotolast || SelmkT |

When the Thumbtack is pushed in the STAY ON TOP feature is active and will stay on top of all other applications.

BEX]

¥ 6AZ6 - Depth of Market

@ || 3 & |&F v (3 & |4l | DEMo9gIgg -
Qty: 113 TatalPAL: $0.00
Pos: o
| CancelBids || Canceltnl |
r
75.15
7514
75.13
75.12
7511
-
| BuwMKT || Gotolast || sSelmkT |

Display Options

Auto Center Price

This Options keeps the MKT prices in the center of the viewable length of the DOM
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Open Order Stats

Provides the total number of open orders for each SIDE at the bottom of each column.

Auto Sum Bid/Ask

e  Adds up the total Volume traded for the BID and OFFER and displays it at the bottom of the respective
columns

®  Open Order Stats and Auto Sum Bid/Ask CAN NOT be active at the same time

Open P/L

Open P/L represents the amount of Profit and Loss when the open position exists. If Open P/L is not checked then
the Total P/L will show. The Total P/L represents the whole profit and loss from all your trades in that DOM.

Open Pos Price

Your open positions average price will be displayed by an arrow. You will see it displayed on the Offer if you are
short and on the Bid if you are long.

Show Tooltip

This options is for first time users of a Depth of Market order ticket. The tooltip allows traders to see what type of
order they can place and where they can place it on the DOM

-~

& DOM Setup
Dizplay | Mumber Pad | Font & Colors

Dizplay ltems

[] Auta Center Price [] OpenP/L

[ ] Open Orders Stats Open Pos Price

At Sum BiddAdsk Show Tooltip

[ k. l [ Cancel ] [ Apply

Number Pad

1. Configure the number pad to the amounts you desire to have in each key punch options

2. Click apply and the Number pad will change without having to reload the Number Pad
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& DOM Setup x|

Configure the number pad

Setto Zern
1 2 3

4 al 10

15 | 20 | 50

Set to Defaults

[ k. H Cancel H Apply

Font & Colors
Allows Traders to change the DOM and the colors of the orders

OCO'’s, Stops, and Trailing Stops can be customized to their own recognizable color for easy view and quick
reference.

e  The option to restore the defaults is available if the color scheme does not work for the trader

& DOM Setup x|

Faont

AaBbvEz [ Change font ... ]

wiorking order colors
oco: |~ |
Stop: | I |~ |
TrailingStop: |_M

[] Save az Defaults [ Load Defaults ]

[ ] l[ Cancel ][ Apply ]




View

Red/Green Indicator

We have also added the high and low of the launched contract to the DOM order ticket. The high of the day is
displayed by a red line and the low is displayed by a green line.

Number Pad

Touch Pad

Number pad is able to be opened and closed with the options at the top of the page that looks like a number pad.

You can change the number template within Display.

,m 6AZ6 - Depth of Market

[ setozen |R B4 [5F ¥ 3 & |4
Qty: 1% TotalPAL:

Pos: 2@7531| [Edtatt
[ CancelBids | [  Cancelasl |

Set to Defaults

il

75 34
Bl - | 7533

OCO Orders

Order Cancel Order (OCO)
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o
Ty

a ([ iz .
‘W|ﬁ‘? 3 |l | DEMO47094 -
Qhy: 5% TatalPAL: $0.00
Paos: 0 @ Confirm orders
0 Buy § ESZ6 LMT 1324.50
r Buy 5§ ESZ6 LMT 1326.00
I
- [ ez ] [ Mo
I
10 132600 [N
B 1882 1325.73
2720 132550
| 2660 132525
132500
I 132475
1324.50 E
Left Click: OCO LIMIT
| BuMKT || Gotolast || selmkT |

1. OCO (One cancels other) is a pair of orders sent together.
2. Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

3.  To send OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

4.  After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).
5. Working OCO orders are displayed in blue color by default.

Order Flags
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# ESZ6 - Depth of Market

BX]

= | [ 5 - = |l | DEMO25830 -
Qty: 0/ Total P/ $1.000.00
Fos: 1]

[ 1324.00
1328.75
1328.50
1328.25
1328.00
2615 132778

1327 RN

S -

Order Flags

) Mone (O GTC O FOK O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled

Stop Limit/Trailing Stop

Stop Limit (STP LMT)

View

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become

MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be

filled unless the price remains at or drops below the limit level

e  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not

be filled unless the price remains at or rises above the limit level

e No order can be guaranteed an execution
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-,

@ ES76 - Depth of Market Mi==
= | [ 5 | ef "?’|i§} |l | DEMO47094 ~

Qty: 5% TatalPAL: $0.00

FPos: 0

r s

1326.75
1326.50
1326.25
1326.00
1325.75
1325.50
1325.25
1:325.00
1324.75

FEEO -

| BwMkT || Gotolast || selmkT |

[] Stop Limit [ ] Trailing Stop
Factor: Factor: 0.25 {3}

Trailing Stop

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis.

Bracket Options
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BE]

132700 B
329

| [F & | v (AlE ||l | DEMo47094 -
Qty: B TatalPAL $0.00
Fos: n

£ Offer

1327.75 232
1327.50 233
1327.25

| 1449 |
N

1326.75

- 10062

| BuwMKT || Gotolast || SelmkT |
[] By Bracket [ ] Sell Bracket
[ ] Sell Limit [ ] Buy Stop
Factar: Factor:
[] 5ell Stop [ ] Buy Limit
Factor: Factor:

View

Buy Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders.

2. A BUY order is bracketed by a high-side sell limit order and a low-side sell stop (or stop-limit) order.

Sell Bracket

1. Bracket orders are designed to limit your loss and lock in a profit by "bracketing" an order with two opposite-side
orders

2. A SELL order is bracketed by a high-side buy stop (or stop-limit) order and a low side buy limit order.

Account Filter

Scroll through various accounts you might have and trade the same contract with a click of a button.

101



OECTraderUserGuide

ESZ6 - Depth of Market

B[]

L

1 | [ & |eF [¥ ] & |l | [oEmozsssn -
Ity D{:} Tatal PAL: CEMCZ5E30

DEMOE5399
Fos: ]

e Offer
1329.25
1329.00
132875
1328.50
132825

-

Goto Last

(PRI
jri=y
[P
] | )

Order Flags
) Mone (O GTC (3 FOE. () 10C

Qty
Amount of contracts you desire to trade for the entire ROE.
@ ESZ6 - Depth of Market mEX]
- | [ & | sF v A G |l | DEMo47oa4 -
Qty: Sl Total PAL: $0.00
Pos: 0

1326.25
1326.00
1325.75
1325.50
1325.2%5

-

| BwMkT || Gotolast || selmkT |

P/L

Open P/L or Current P/L
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@ ESZ6 - Depth of Market Mm=E[X]
=M | [F & |af v 245 |Hll|  DEMozssan -
Oy 04 | Total P/ $1.000.00
Pos: 0

-
I 1329.25
1329.00

i1 I 1328.75
1328.50
4 | 1328.25

w

Gioto Last

1. Open P/L is the Profit and Lose for the Position that is open currently

2. Current P/L is the Profit and Lose for all positions that have been traded on this session

Position

Shows the amount of contracts you have open and at what price they are open at.

B[]

L

ESZ6 - Depth of Market

| [ & |Bf v (3 5 (| DEMO2S830 -
Qty: Bl&  Total P/ $ 81250
Fios: 5= 1323.50 [ Exit at MET ] [ Reverse ]
| CancelBids || Cancelal |
1348 132925 N
1124 12900 [
| 3661 | 122875 [
2621 1:2a50 (DD
3932 12625 [
| 4 | 132800 [
N 132775
1] 1327.50 [
132725
. 1327.00 [
] 12675
| 1| 132650 [N
1326, 25
-
| BwMkT || Gotolast || selmkT |

View
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Exit at MKT

Turns any open position into a FLAT position by trading the opposite of the open position.

e
" c X

=4 | [ 5 "E’ 3 S [l | Demozss30 -
Qty: 5% TotalPAL $ 91250
Foz: 5132375 [ Exit at tET l [ Reverse ]
| CancelBids || Cancela |
[ 1330.00 3947
Bl - » 13297 1370
[ 1061 | 132950 (Fm o =
7459 1379 75 # Order Confirmation
: g;gi Egggg Account: DEMO 25830
4432 1328.50 Send SELL 5 ESZ6 MKT?
| 8 |
1328.25
N 1328.00
e Eg;;g | ok | | Cancel
I 172725
1327.00
-
| BwMkT || Gotolast || selmkT |

Reverse

Will take any open position and EXIT it and then reverse the position by placing the identical position on the reverse
side. it was initially open on.

i.e., ES 1 @ 1329.75 and reverse the position it would end up ES -1 @ 1329.75
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(¢ X
=A | [F & |&f v (3 G |Gl | DEMO2S830 -
Qty: 1 Total P/ $ 725,00
Pos: 1@ 1329.75 [ Exit at MKT ] [ Feverse ]

Offer

m Order Confirmation

=,

id -~
EXN 7 p 13297
1329.50
1329.25
3475 1329.00
1328.75
1323.50
“ 1328.25
“ 1328.00
- 1327.75
- 132750
- 132725
- 1327.00
u 1326.75

B |
B

Accaunt: DEMOZ5830
Send SELL 2 ES5Z6 MET?

3

[ QK. ] [ Cancel

Buy MET

] [ Go to Last ]

| selMkT |

Cancel orders

W £S76 - Depth of Market M=}
M | (3 & |=f ¥ (A& ||  DEMO25830 -
Qty: 118 TotalPAL $ B57.50
Poz -1 @ 133025 [ Exit at MET ] [ Reverze ]
[ Cancel Bids ] [ Cancel &ll ] [ Canicel Offers ]
Bid - Dffer
I 12332 [
N 122200
N 123275 [HEE
N 123250 [
N 12222
N 122z00
N 122175 [
N 1331.50
I 13125  [EEFl
v
| BwMKT || Gotolast || selmkT |

Cancel Bids

View
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This options will cancel out of all working orders on the BID side

Cancel All

This will cancel ALL working orders

Cancel Offers

Will cancel out of all working orders on the OFFER side

At Market

# £576 - Depth of Market Mi==

= | [F & |EF v (A 4G || DEmMozssso -

Qty: 13 TotalPAL % £37.50

Foz: 1= 133025 [ Euit at MET ] [ Feverze ]

[ Cancel Bids ] [ Cancel Al ] [ Cancel Offers ]
- Offer
133325 [
1333.00 Il
133275
133250 [
133225 [
1332.00 [
1331.75 [
1331.50
1331.25 3327

w

| BuMKT || Gotolast || selMkT |

Buy MKT

Place a Buy @ MKT at the bid price

Go to Last

Will center the MKT Prices; without having to scroll; if they have trailed off the existing view

Sell MKT

Will place a Sell @ MKT at the offer price

View Quotes
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=ymbal
ZNUE
Bl
WG
SllUe
=B
MOLIE
HOLE
GCOE
FDAXLIE
ER2LB
CLvk
cUB

Last
107 04.0
110 11
3.9700
12.490
04175
1658225
1.8530
B10.4
o872 A
7218
7010
2.26875

Last®'ol

—_

DO MR EOCO =000 0am

Bid

107 04.0
110 10
0.0000
0.000
0.0000
155225
1.9440
0.0
fa720
217
0.00
0.0000

BidSize
1642
2111

0

~ oo —=>00

=

Ask
107 04.5
110 11
3.8900
12.410
54050
1582.75
1.9500
0.0
58725
72149
0.00
0.0000

AskSize
2033
708

View

The columns can be configured to be displayed or hidden. Below is a list with all the columns available from the

Quotes window.

Symbol

The contract symbol.

Last

Last price at which the contract was traded.

LastVol

The last amount of Volume that trade that specific contract.

Bid

The bid market price.

BidSize

The total amount of bids on that contract.

Ask

The offer market price.

AskSize

The total amount of offers on that contract.

High

The highest price traded of the contract during this trading session.

Low

The lowest price traded of that highlighted contract during the most current trading session.

Chg

The total amount of change from the opening of the current trading session.

Chg%
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The total percentage of change from prev. day settlement.

TotalVol

The total volume traded on that specific contract through the current trading session.

Open

What the price was of the contract at the opening of the current session.

Settle

What the contract price was at the end of the most recent close.

Updated

The most recent time at which the contract’s price, bid/ask, volume etc was updated.

Base Contract

The symbol of the contract that is being traded without the year or month attached. e.g: The ESU6’s base
contract is ES.
Expires

The date the contract will no longer be available to be traded.

Description
The name of the contract. e.g: 2. The ES has a description of E-Mini S&P.

Currency
The currency that the contract is traded in. e.g: 2. ES E-Mini S&P trades in USD and DAX DAX trades in EUR.

Exchange

The exchange that the selected contract is traded on.

Group

The group that the selected contracts falls under e.g. ES is a contract under the Indices Group .

Type
Whether the contract is traded electronically (E) or pit (P).

Start Time

What time the contract opens in relation to the exchange’s time zone. E.g. CME is Chicago Mercantile
Exchange which is located in Chicago, IL on Central Standard Time (CST).

Stop Time

The time the contract closes in relation to the exchange’s time zone.

Tick Size

What the increment amount is per tick. The ES has a Tick Size of .25. e.g. ES has gone from 1309.50 to 1310
therefore it has increased by 2 ticks .

Per Point



View

The total amount of amount effected per point. The ES has a Per Point value of 50. This mean that if the
market moved up one point from 1309 to 1310 someone who was Long would make $50 on a 1 lot. To find out
the per tick value, multiple the Per Point value by the Tick Size. 50 x .25 = 12.50 per tick for the ES.

Charts

Charts - Open

a. Left-click on VIEW in the Toolbar Scroll down to CHARTS one up from the bottom
1. Click on NEW and Market Selection will prompt you
e  Enter the Market you want and click ok
2. Click on anything below the line i.e. Chart — 15 min (ESUG6)

e Thisis a chart that you have either opened during this current session or a chart that you have
save

b. Right Click on the contract you want in the QUOTES box

a. Scroll down to CHARTS one up from the bottom and the chart will appear
c. Launch a DOM

1. In the top toolbar below the title bar will be a set of icons

2. The eight icon from the left looks like a bar chart

3. Put you mouse on it, so it is highlighted and left-click

4. The chart will appear for that DOM
Add Indicator

Add Indicator
Customize or select from a variety of indicators and profiles.
1. Click on ADD INDICATORS in the top left corner of the chart

2. Add indicators via RIGHT_CLICK shortcut. Right-Click any where on the graph and have a menu bow pop up
and select ADD INDICATORS.
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'@ Chart - 15 min (ESU6) MmE<]

Contrack,., |&dd Indicatar | 15 min * CHLC

L\ High 12 Channels ] I
n | Open 12 Diata b - 130475
BN Moving Averages F
F1302.00
i Oscilliakor L ETEE
| Prices r
: 1247 50
al qui Trend Followers 3 C 298 50
{—i;’ @ 208 Yalatility »
+ Iiﬁ Valumes N #ﬁ'
iy @ Connected | 08/24/2006 16:30 10:44:01 AM

Volatility
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View

-
# Chart - 15 min (ESUS)
Conkract... | Add Indicator = | 15 min
L\ High 12 Channels
~4 Open 13 Data
b Moving Averages
i Oseilliakar
| _F‘ﬁ Prices
i H.ri Trend Followers
F{" @ m| Wolakility r Average True Range
1 % Yaolurmes » Standard Deviation
i @ Connected | 08/20/2006 17:15 velatily
Wolatility Chaikins
Walakility R.atio

Average True Range (ATR)
e  Appears below Contract chart

e  Measures commitment comparing the range between High, Low and Close prices

Standard Deviation (StdDev)
®  Appears below Contract chart

e  Difference between values (Closing Price) and average.

Volatility (Volatility)

e  Appears below Contract chart

Volatility Chaikins (CHV)
e  Appears below Contract chart

e  Difference between high and low prices, indicates the top and bottom of the market

Volatility Ratio (VR)

®  Appears below Contract chart

Channels
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'@ Chart - 15 min (ESU6) LoE)

Contract,,. | &dd Indicator = | 15 min = OHLZ = A
L, High 1E| Channels » EBollinger Band
*, LOpen 12 Datka b Caornmrmadity Channel Index
o Moving Averages 3 Envelopes
_s Oseilliabar [ Keltner Channel
| Prices k
. ;‘II Trend Followers 3
{?r"l & 2006 Wolatility 3
1 % Yolurnes 3

_ﬂ @ Connected | 082002006 17115 10:54:05 4M

Bollinger Band
e Wil put a Bollinger Band on the chart directly

e This indicator can be used to measure the relative highness or lowness of price

Commodity Channel Index
e Wil put a Chart below the existing Contract chart

e  Compares Prices with its moving average

Envelope
e Wil apply a envelop directly on the contract chart

e  Plots above and below the moving average at a specified percentage

Keltner Channel
e Wil apply 3 lines to the Contract chart

e  This indicator shows a central moving average line plus channel lines at a distance above and below

Data
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# Chart - 15 min (ESU6)

L

™
W

Conkrack,., |Add Indicatar = 15 min
High 12 | Channels
Open 13| Data

Wi

& 2008

o

Moving Averages
Oscilliator

Prices

Trend Followers
Wolatility

Yolumes

B @ Connected | 08/20/2006 17:15

10:57:42 AM :

Volume

Moving Averages

Will put a volume chart below the contract chart

Shows the amount of trades at a specific time of the day

# Chart - 15 min (ESU6)

BEx]

Contract...

L, |

i
W

iy

= 2008

=

Exponential M.A. (EMA)

Will apply a line direct to Contract Chart

&dd Indicator = | 15 min = OHLC +
Channels 3 r
Data * F1304.75

| Moving Averages 2 Exponential Maoving &verage
Oecilliakor J Least Square Moving Average
Prices L Rolling Mowing Average
Trend Followers ] Simple Maving &vwverage
Wolakility k Triangular Moving &wverage
Yalumes » Triple Maving Average

iw @ Connected | 08/20/2006 17:15 Variable Moving Average
Weighted Moving Average

View

EMA is an average of data calculated over a period of time where the most recent days have more weight

Least Square M.A. (LSMA)

Will apply a line direct to the Contract chart

Rolling M.A. (RMA)

Will apply line direct to Contract chart
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Simple M.A. (SMA)
e Wil apply line direct to Contract chart

e  The average of data calculated over a period of time

Triangular M.A. (TMA)
e  Direct line onto Contract chart

e  Average calculated over a period of time where the middle portion of the data has more weight

Triple M.A.

e  Applies 3 lines on Contract chart, the Slow, the Fast and the Median

Variable M.A.

e Wil apply line direct to Contract chart

Weighted M.A.
e  Direct onto the Contract chart

e An Average where the greater weights are attached to the most recent data, it is calculated from the sum

of the day
Oscillator
- -,
# Chart - 15 min (ESU6) M=}
Conkract... | &dd Indicatar =| 15 min * OHLC ~
L vigh 12 Channels k r
i Jpen 14 Data 4 L 1304.75
b Moving Averages » )
_ | Oscilliakor » fwverage Directional Indes
| Prices L Cetrended Price Oscillator
. ':'Ii Trend Followers 3 Mornenkum
(i @ 2006 Yolatility 4 Perfarmance
+ % Yalumes k Price Oscilliator
i) @ Connected | njz0/2006 17:15 Rate Of Change
Relative Strength Indes
Stochastic
William's %R

Average Directional Index
e  Will appear below the Contract chart

e Wil have three lines, ADX, -DlI, +DI

Detrended Price Oscillator

e  Will appear below Contract chart
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View

e  The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any
other price with it's moving average

Momentum

. Will appear below the Contract chart

Performance
e Will appear under the Contract chart

e  Compares the current Close (or any other price) with the first Close value. Shows how much the Close
price was changed from the beginning

Price Oscillator
e Wil display below Contract chart
e  Rate of Change

e Appears below Contract chart

Relative Strength Index
e  Appears below Contract chart

e  Compares upward movement of the Close price with the downward movement resulting in a value which
ranges from 0 and 100

Stochastic (%K, %D)
®  Appears below Contract chart

e Indicator helps to find trend reversal searching for a period when close prices is close to low price in up
trending market or close prices is close to high price in down trending market

William’s %R (%R)
®  Places the charting below the Contract chart

e  This indicator is used to measure overbought and oversold levels

Prices
[
# Chart - 15 min (ESU6)
Conkractk,.. |&dd Indicator - | 15 rnint
h High 12 Channels
x\ Open 13 Data
BN Moving Averages
s Oscilliator
| | Prices L4 | Median Price
. Trend Faollowers 3 Typical Price
{—i;’ & 2006 Wolakility k Weighted Close
1’_ % valumes b _
2 Conmected | 08/20/2006 17:15 11:15:30 AM
o
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Median Price (Median)

®  Places a line directly on the Contract chart

e  Mid-point value of daily prices

Typical Price (Typical)
e  Appears directly on the Contract chart

e  The average value of the daily prices

Weighted Close (Weighted)

e  Appears direct to the Contract chart

[ ]
important price

Trend Followers

Average value of daily prices, only difference is that the closing price has extra weight as the most

# Chart - 15 min (ESU6)

o

Contract... | Add Indicator - | 15 min

Lx High 12 Channels

\\ Open 13 Data

= Maving Averages

s Oscilliakor
Prices

ALC H‘iﬁi Trend Followers 3 | MACD

Ff’ 2 2006 Wolatilicy » Mass Index
Yolumes 3

Tangent of Linear Regression

_ﬂ' Connected | 08/20/2006 17:15

TRIX

R —

MACD (MACD, Histogram, Signal)
e  Appears below Contract chart

e  Compares two moving averages of prices.

Mass Index (Ml)
e  Below the Contract chart

Is used with its 9 day Exponential Moving average as signal

Developed to predict trend reversal by comparing difference and range between high and low prices

Tangent of Linear Regression (Tangent)

®  Appears below Contract chart

TRIX (TRIX)

(] Below Contract chart

Volumes
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'@ Chart - 15 min (ESU6) m=Ex|

Contrack,.. |&dd Indicatar | 15 min = OHLC

h High 12 Channels 3

Open 13
o Data v L 1304.75
b Moving Averages k
N F120z2.00
C=cilliator 2

| Prices »
- .ﬂ‘“ Trend Followers 3
{?.-*’ & 206 Wolatility 3 m
1 Iiic_alﬁl Yolurmes » Accurnulation/Diskribution

_ﬂi Connected | 05/20/2006 17:15 Ease of Movement

Money Flow Index

Meqative Volume Index
on Balance Yolume
Positive Yolurne Index
Price Yolume Trend

Volurme Oscillakor

Accumulation/Distribution (A/D)
®  Appears below Contract chart

e  Estimates the strength of price movement with the relationship between volume and prices

Ease of Movement (EoM)
e  Appears below Contract chart

e  Uses volume to estimate how strong the price trend is

Money Flow Index (MFI)
®  Appears below Contract chart

e  Compares upward changes and downward changes of the volume weighted typical prices

Negative Volume Index (NVI)
e  Appears below Contract chart
e Should be used with PVI

e  Changes only if the volume decreases from the previous day

On Balance Volume (OBV)
e  Appears below Contract chart
®  Measures positive and negative volume flows.

e  Volume is added if the closing price moves up and subtracted if the closing price moves down

Positive Volume Index (PVI)

View
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®  Appears below Contract chart
e  Should be used with NVI

e  Changes only if the volume decreases from the previous day

Price Volume Trend (PVT)
e  Appears below Contract chart
e  Cumulative volume total

e  Calculated by using the relative changes of the Close price

Volume Oscillator (VO)
e  Appears below Contract chart
e  Tries to identify any trends in volume, comparing two moving averages; one with a short period and the
second with a longer period
Period

This function allows you to set the time period for each unit (e.g. bar, candlestick, etc.) of your chart. The minimum
time increment is 1 minute, and the platform can be configured to display periods of length up to one day.

¥ 1
& Chart - 1 min (ESU6) M=l
Contract... #Add Indicator -+ |1 min | OHLC -

L\ - 1 raim ~
High 1305.50  Lows 1305, 2 Imin ot
3 Open 130323 Close 1305153 min
b 4 mir
e H1302.75
i F1302.50
| F1301.25
ARC
{___ F1300.00
1
*¢'| @ 2006 Dpen E Ciy, LLC ﬁi'm
t : :
i €} Connected | 08)'28/2006 04:29 11:33:10 &AM
Profile
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View

-
# Chart - 3 min (ESU6) Mm%
Contract...  Add Indicator = 3 min * OHLC =
Lk High 1304.00  Lowe 130400
\\ Open 130400 Claze 130400 i
R Properties  insso
| X
| Add Indicator 130075
Period L1293.00
Profile Save Profile. . I
Area Save As Defaudlt, .,
Serigs Delete Profile, ..
Drawing Tools Select Profile 9 A
Expork Bollinger Band
Auka Scrall Yolumes
Offset Farmenturm
b ZoomIn Chrl+I Default
= Zoom Out Chrl+0 areen On Black

Save Profile

This allows you to save the currently selected chart with all of its settings for future use. Upon selection, this
feature presents you with the opportunity to use a default chart name or create your own chart title for increased

customization and personalization.

Save as Default

This allows you to not only save the currently selected chart but also to set it to your default chart upon the

launching of the platform. This function is recommended for what each trader would consider being the chart

from which he/she obtains the most utility.

Delete Profile

This allows you to remove a previously saved profile.

Select Profile

ADX (Average Directional Index)

This indicator evaluates the strength of the current market trend. The resulting figure is one that indicates
relative strength, with further implication upon the trading style that will prove most effective in a given
market. The oscillator fluctuates from 0 to 100; readings above 40 indicate a strong trend, while readings
below 20 indicate one of relative weakness.

Bollinger Band

These are indicators placed at standard deviation levels away from a simple moving average. The
resultant standard deviation derived from the applied formula indicates the relative volatility of the market.
Volumes

This indicator simply displays different levels of volume in a given market. A volume oscillator is intended
to compare moving averages of varying time periods to compare volumes.
Momentum

The momentum profile provides the trader with a simple moving average on the chart, and, in addition,
charts indicating the momentum and RSI of the market at its current state.
Default
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120

This function returns the trader to the chart profile that he/she has saved as the contract's default profile.

vi. Green on Black: This chart is differentiated largely by its aesthetic divergence from other charts; what
was once a chart of black lines against a white background is now one of green lines against a black
background.

Area

Allows you the ability to see properties of series, removes series, Freeze Limits or Auto Limits

NOT

E: the Contract chart will be the default chart unless you right-click on the Line or chart you want. You will know

the Chart has been selected because it will have points highlighted along the line itself.

-~

Chart - 3 min (ESU6) mEX]

Conkrack,.. Add Indicatar = 3 min * OHLC -

L,

High 130400  Low 130400

E
W

Open 130400 Close 130400

Properties
bo

1304.00

F1302.23

F1300.50

Ser

Add Indicator b
Period k 129873
Profile b

| Area L4 | Properties: Chark Area 1
Series 3
Drawing Tools 3 Freeze Limits
Export R Auta Limits

Properties: Chart Area X

Will open the Properties box on the right side of the Chart. With this you can change around and customize
appearance. (SEE SELECT PROFILE > 3. PROPERTIES BOX)

Remove: Chart Area X

Will remove the selected chart from all chart area.

Freeze Limits

Freeze limit will capture the high and low prices of the currently viewed chart window. Once the prices have
been captured the viewable window will not change, therefore not allowing the chart to be viewed above or
below the high or low price which was frozen.

Auto Limits

Auto limit allows the viewable chart to adjust to the necessary prices accordingly. The high and the low of a
specific contract will adjust its scale depending on how high or low the market price diverges from the initial
median price.

ies



View

-
# Chart - 3 min (ESU6)
Contract,,. Add Indicator = 3 min = OHLC
L\ High 1304.00  Lews 1304.00
Open 1304.00 Close 1304.00 T
\\"- LT LT §_ T 7 1304 .00
> Properties
= 1302 .25
F1300.50
| Add Indicakar 3
AEC Period 3 [ 1255 75
(i) Profile 3
T ares [
| Series r
Drawing Tools * Save As Default
Expork r Indicators...
—

Move to New Area

Once a chart indicator has been highlighted by right-clicking on the desired chart, traders can move the chart to
a new viewable window below the contract chart window. A number of indicators already start in a new chart
area . Some of the moving averages for example appear directly on the contract chart, thus being able to be
moved to a new chart area.

Save As Default

Saves properties as default for newly created series of the same type.

Indicators...

Shows the Indicator List Dialog. The Indicator List dialog allows traders to remove indicators or modify
properties of the selected indicator.

Drawing Tools
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m Chart

- 3 min (ESU6)

Contract...

add Indicator + 3 min

Lk High

g L

120375 Lowe 130273
1203.75 Clase 130273

| B
bos

Properties

Add Indicatar
Period

Prafile

Area

Seties

F1302.23

F1300.50

12:09:43 PM

| Drawing Tools | Painker
Export | Trend
Auka Scroll M| Line
Offset G,J Callout
4k ZoomIn Chrl+I A€ Text
= | Foom Ogk CErl — | Horizontal Line
Data B | | wertical Line
Crosshair Mode p | T Arrow
Load More Data By  Send TaBack
| volume T} Ering To Front
Allow Selecting
Select Al
Pointer

Allows traders to highlight specific area by dragging the cursor. Once highlighted the trader can zoom in on the
highlighted area.

Trend

Displays trend lines with 3 lines. The standard deviation, the variance and the average. This can be adapted
by only the trends of the Chart, they are not free flowing and they are not dependent on the y axis or price.
Line

This is a free flowing chart that can be changed with not regards to either the x or y axles.

Callout

This allows traders to place call outs attached to specific high or lows at a certain time. Traders can put
whatever they desire in the call outs.

Text

Text is an option where traders can put text on the chart not dependent on anything but their text within the text
box.



View

Horizontal Line

This line can ONLY move horizontally no matter how vertical your diverge from the initial point on the line.

Vertical Line

This line can ONLy move vertically no matter how horizontal you diverge from the initial point on the line.

Arrow
Place thick highlighted arrow anywhere on the chart.

Send to Back

The options send the highlighted chart to the back of all the other charts on that same chart area.

Bring to Front

This options sends the highlighted chart to the front of all the other charts on the same chart area.

Drawing Properties

Allows you to customize the drawing properties of the previously placed drawing tools.

123



OECTraderUserGuide

# Chart - 15 min (6AU6)
Contract... Add Indicator - 1t

L\ High 75.33  Low 7929
3 Open 75.23 Close 75.33 I

J | |
\\\ I'lll 4

Contrack... Add Indicakor + 15 min * OHLC + Indicators... Select Profile -
High 75.33  Low 75.3 Vertical = @
3 Open 75.34 Close 753
B Appearance
W h i Colar Bl Red I[{rl-. j-}
-| - nd Cap iamon W T
| it g EndC Diamond | &
i l “ Mode Finite J_J_ﬂ 1 ‘J
| | Start Cap Arrow I I‘
P m Style F Solid
| i =K f
G -
.T.
>
T
ﬁ 1] 05:00
) Connected | 09410 [] Save as Default

In the example above the trader drew a vertical line then while the line or object is highlighted, left-clicked
‘Drawing Properties' in the left panel to view the properties window of my vertical line. | selected Color: Red,
End Cap Diamond, Mode: Finite, Start Cap: Arrow, Style: Solid, Width:6.

Remove Drawing Object

The will remove the highlighted drawing from the chart area.
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View

Allow Selecting

When 'Allow Selecting' is checked, the trader is able to highlight or select the drawn objects in the chart by
performing a left-click on the desired object.

Select All

It will highlight or select all the objects drawn on the chart.

Export

Print

This function allows the trader to send the currently selected chart image to a printer of his/her choice.

Save Image

This allows the trader to save the currently selected chart as an image of specified file type on his/her computer
or external drive.

Save XML

This allows the trader to save the currently selected chart as an image in XML format, which is then available
for use for generation in other applications.

Copy

This allows the trader to copy the image of the currently selected chart to be able to paste into other
applications.

Auto scroll

# Chart - 3 min (ESU6)

Contrack,,, Add Indicator = 3 min * OHLC

L. High 1303.75  Low 130373
Open 130375 Claze 130375
™

B Properties
X F1302.25
F1300.50
| &dd Indicator 3
AR Period 1
f_? 4 Prafile »
t Area k
Serips , 12:14:59 PM
Drawing Tools »
Expork k
Auko Scrall

This provides a constant timeframe for the chart. In other words, as the day progresses and the chart extends out to
the right, the data displayed on the chart will systematically progress toward the left in order to keep the most recent
data on the right side of the chart. Auto scroll can be selected (checked) or deselected (unchecked).
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Offset

This causes the display of the chart to have a relatively small blank area in between the most recent market data and
the far right edge of the chart. Itis largely used for the increased ease in visual distinction it provides with respect to
market data. Offset can be selected (checked) or deselected (unchecked).

Zoom In (CTRL+I)

This allows the trader to decrease the amount of data viewed at one time on a chart. It allows him/her to more
closely see short-term market movements.

Zoom Out (CTRL+O)

This allows the trader to increase the amount of data viewed at one time on a chart. It allows him/her to better see
long-term market trends.

Data Box

This allows the trader to toggle the data box containing data such as market high, low, open, and close, normally
located in the top left corner of the chart on (checked) or off (unchecked).

Crosshair Mode

This option allows the user to specify how he/she would like the crosshair feature (red cross on the chart) to be
displayed.

Hidden

The crosshairs are not visible
on the chart

Free

The user must click on a
location on the chart to make
them appear. Upon
placement, they do not move
unless reassigned.

Mouse

The crosshairs move
unrestricted in conjunction
with the user's mouse
movements.

StickyClick

The vertical bar moves
somewhat freely ("stickily")
with the user's mouse
movements, but the
horizontal bar changes only
upon the user's specification
by mouse click.

Sticky

The crosshairs move
somewhat freely (“stickily")
with the user's mouse
movements.

Load More Data



View

Load more data allows the trader to increase their viewable charts by simply clicking on the load more data. This will

decrease the size of the scroll bar therefore increase the amount of data available to be viewed. The Zoom in and

Zoom out are not effected by this option. Load More Data basically provides as much data as possible on the charts,

allowing the trader to view multiple days if not weeks of data on one chart.

Volume

Select "Volume" in the sub menu.

# Chart - 3 min (ESU6)

BEX]

Volume view

Crosshair Made

Load Maore Data

Yolume

Contract... Add Indicator + 3 min * OHLC * Indicators...
L High 130325 Low 130300
- Open 1[[?1]3125 Claze 1303.00 X
W yry1r o F“! E 130375
L WWQF Add Indicakor
T Period 1301 50
| Prafile .
AR
i Area L 129925
| Series
+
| #2006 Dpen E Ciy, LLC Drawing Tools
;
01:00 Export
iy @ Connected | 08/24/2006 03: Auto Scrol 12:26:28 PM
Offset
gp | Zoom In Chrl+1
= Foorn Out ChrlH0
Daka Box
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# Chart - 3 min (ESU6)

BEx]

Contrack,.. Add Indicator + 3 min

+ Indicators. .,

L\ High 1303.00  Low 1302.73
3 Open 130275 Clase 1303.00

“alume 1 t
s

e [EIE

0100

% 2008 Open E Ciy, LLC

12375

v € Connected | 08242006 03:51

12:27:40 PM

Chart Properties

Properties
Current Profile

Appearance

The chart properties are fully customizable.

# Chart - 15 min (ESZ6)

BEx]

Contract,,,  Add Indicator = 15 min = OHLC = Indicators,,, Select Profile - H |
L, | " lyssops | Propeties |Data | Indicators
4 Current Profil v
. % urrent Profile ..v:
B B Appearance ]
B 134723 Background Color [ ] White
L1245 75 Background Gradier [ White
I B Bid/Ask
A 134423 Ak Color [ ] Silver
] L1242 75 Bid Colar [ ] Silver =
(i} ShowBid/isk  False
t (131550 Data Box
. Crozzhair on Mousze  Sticky
Font Anal b 75 Regular
pre Show OHLC True
i Source Crozshair -
L 2006 Open E Ciy, LLC Yizibility AutoHide B
! EH Gnd and others B |
10401 Cursor Red, 1, Sold [l
,'i Connected | 0926/ 2006 16;30 10;34:08 AM




Background Color

The background can be customized by selecting any color from the drop box to the right. The color will appear
on the back of the chart.

Background Gradient

This is the second color of the background. This allows the two colors to blend together. This color will be bold
in the bottom right corner while the primary color will be bold in the top left corner.

Conkrack, ..

&dd Indicatar = 15 min

* oHLZ

= Indicatars,., Select Praofile = ﬂ |

View

~
R

i

i B BTN RSO S

High 133225  Low 1337.40
Open 1338.00 Close 1337.75

,,'D Connecked | 09/26/2006 16:30

Bid/Ask

350,23

F1345.73

134723

F1345.75

134423

F1342.73

F1341.23

F1336.73

Properties

Data | Indicators

Current Profile

El Appearance

B ackaground Caolar
Background Gradient [ ] ‘White

[_] white

E BidsfA
Bugk Cg
Bid Col
Shiow §

E Data
Crozzh
Font
Shiow
Source
YWizibility

B Gnd 3

Curgzor

Custom | “'eb

System

[ Trangzparent
I Elack

1 'White

I DrirnlGray
B Gray

3 DarkGray
[ Silver

[ LightGray
[ Gainshara
1 'wWhiteSmoke
I 1 aroon
I DakFed
I Red

I Erovn

| Firehrick

><E]hl
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Contract... Add Indicakor + 15 min * OHLC + Indicators. .. .-
L, Properties | Data | Indicators
F1350.25
b Current Profile o
e (1343009 Appearance
Background Color [ ] White
_ H1347 .75 . .
Background Gradient [__] ‘White
I i B Bid/Ask
134650
Arn Azl Color [ Silver
(1 F1345.25 Bid Color [ Silver
i Show Bid/dsk False
1 r1344.00 E Data Box Tre
. Crozzhair on Mouze  |Falze
? F1342.73 Font
Show OHLC True
F1341.50
X Source Crozshair
B 1340 25 isibility AutoHide
[t . 1 E Grid and others
Ask Color
The color of the Ask price on the Y axis.
Bid Color
The color of the Bid price on the Y axis.
Contrack,,. Add Indicator = 15 min * OHLC = Indicators.,. Select Profile - E | "
High 1347.75 Low 134725 Fropertties | Dats | Indicators -}
Open 1347 25 Close 1347 78 I
™~ i DS; 134923 Current Prafile Lo
| |
B I % Background Gradient || White -
) B Bid/Ask
134525 Ak Calar [ Silver
I s 2o Bid Color [ Silver
AEC . Shiow § Custom | eb
i 134125 E Data [ Tranzparent S
o Crassh) | Black
+ Font || wWhite
. Show (| | DrimiGray
. 1337 .25 Source E gfaiﬁ
5 || ® 2006 Open E Cip. LLC Visibiltd | s
| E Grid g | LightGray -
By s 1 Gainsboro .
o @ Connected | 09(26/2006 16:30 EHQ’;ﬁkaE 4
I [ arkRed
I Red
I Erowin
[ Firehyick s

Sho

w Bid/Ask




Dat

View

When ‘False’ is present the Bid/Ask price are not visible. Click on ‘False’ and change it to ‘True’ allowing the
Bid/Ask to be viewed for the most current price.

Contract... Add Indicakor + 15 min * OHLC + Indicatars. .. .-
IE I Propetties | Data | Indicators
H1350.25
4 Current Prafile v
W [1349.00 E Appearance
Background Color - [_] 'White
= F13d47.73 . -
Background Gradient [ ] White
I id/As
I jaes0 | B BidfAsk
a gk, Color [ Silver
| H13245 25 Eid Calor [ Silver
(i} Show Bid/sk False
t r1344.00 | |F Data Box True
. Crogzhair on Mouse  |Falze
F1342.73 Fant
Show OHLC True
F1341.50
X Source Crozzhair
B 1340 55 isibility AutoHide
gt . 1 E Grid and others
a Box

§
(el

Chart - 15 min (ESZ6)

BE]

Contract... Add Indicator ~ 15 min = OHLC = Indicators... Select Profile - _
L, | I | 1am005 | Froperties | Data | Indicators
) g s | | Curent Pofle v
S Eli Data Box ~
i 134723 Crozzhair on Mouze  Shicky
L1345 75 Font Microzoft Sanz Seri
I Show OHLC True
AED 134423 Source Crozshair
] 240 75 Yizibility AutoHide
{?r" E Gnd and others
+ r134.23 Curgor RHed. 1. Solid
i Horizontal Tick Marks, Gnd L
Selection Color I Gray
s Wertical Tick Marks, Gnd L
i E Scrolling
By Auto Scroll True
Show Right Margin -~ False
T L
,,:"D Connected | 09/26) 2006 16:30 10;21:56 4M

Crosshair on Mouse
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Contrack,.. Add Indicator = 15 min * OHLC = Indicatars... Select Profile - .-
L, 125025 | Fropeties | Data | Indicators B
b 1348 75 Current Profile w
W B Data Box A
p [1347.23 Crozzhair on Mouze  Sticky W
L1345.75 Fant Hidden
I Shaw OHLC Free
. [1344.25 Source Mpuse .
] 1242 75 Wizibility Stickyllick
(i] u B Grid and others  |Sticky
Hidden - ) ' T
The crosshairs are not visible on the chart
Free

The user must click on a location on the chart to make them appear. Upon placement, they do not move
unless reassigned.
Mouse

The crosshairs move unrestricted in conjunction with the user's mouse movements.
StickyClick

The vertical bar moves somewhat freely ("stickily") with the user's mouse movements, but the horizontal
bar changes only upon the user's specification by mouse click.
Sticky

The crosshairs move somewhat freely ("stickily") with the user's mouse movements.

Font

Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;
aka OHLC (Top left corner by default).
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Contrack,..  Add Indicakor ~ 15 min * OHLC = Indicators... Seleck Profile - E | "
E ' 135025 | Froperties | Data | Indicators
b | 1248 75 Current Prafile L
R Shaow Bid/Adzk False -
) [1347.23 E Data Box
H1345.75 Crosshair on Mouse Sticky
| Fort Anal 6.75 Regular
L
=
0 Font: Fart style: Cizen
| Avial Regular !
) avial | [Fegular 8 A
()} Arial Black [talic 9 SICS
o () Avial Narrow Bold 10
H Batang Bold Italic 11
T @00 Openl | BatangChe 12
ﬁ {} Book Antiqua 14
- (} Bockman OId Style [¥ 16 |»
" @ Connected Effects Sample
[ 5tikeout
PabbyZz
[ Underline ¥
Script:
Western w

><E]h'

Show OHLC
The Open High Low Close is by default displayed in the top left corner. It tracks the data that your mouse is
moving over.
Contract,., Add Indicator = 15 min = OHLC » Indicators,.,  Select Profile - E |
L | jssnss | FTopetties | Data | Indicators
™~ | 248 75 Current Prafile
e Shaow BidAdsk Falze
§ 134725 H Data Box
H1345.75 Croszhair on Mouze Sticky
| Font Anal 6. 75 _Regular
- [1aad.23 Show OHLC Tiue
. H3de 75 Source True
Lig | — MW || vishily False
| “ 134125 O Peid amd Abhnren
Source

Provides the type of data that will appear in the OHLC box in the top right corner.
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.. Select Profile ~ i |

Contract,,, Add Indicatar = 15 min * (OHLC = Indicators B
L, | uspzs | Propetties | Data | Indicators
™~ | 4242 75 Current Prafile L
B B Data Box S
B [1347.25 Crozzhair on Mouze Sticky
H1345 .75 Font Anal b. 75, Regular
I Show OHLC True
B 134423 Source Croszshair
a L1347 75 Wisibility Last
o El Grid and others |Mouse
t Cursar Crozzhair
(o B PN Y | T T =TT LT
Last
The most current data presented in the OHLC.
Mouse
Presents the data from the location of your mouse on the chart.
Crosshair
Presents the strict data from exactly where the crosshairs are in relation to the contract chart.
Visibility
Contract... Add Indicator = 15 min - OHLC = Indicators... Select Profile « [& | =
High 1347.75  Low 1347.25 L iamazs | Cropeties | Data | Indicators =
Open 134750 Close 1347.25 -
™. | 248 75 Current Prafile W
W 1 WM | B Data Box A
) | Crozzhair on Mouze Sticky
F1345.75 Font Arial,6. 75 Regular
I Show OHLE True
A 134423 Source Crosshair
| 1542 75 Wisibility AutoHide
Ff’ El Gnd and otherz [Vizible
t 134123 Curgar Hidden
i l_1333 15 Harizankal AutoHide
o | |1 | I C lembiman, Tl r—
Visible

The OHLC will always be on the chart.

Hidden

The OHLC will never be on the chart.
AutoHide

The OHLC will hide when the cursor is off the chart and will appear when the cursor moves over the chart.

Grid and Others



View

& Chart - 15 min (ESZ6) =Jo&d
Contrack... Add Indicator = 15 min * OHLC + Indicators... Select Profile - E | ]
LIl High 134550 Low 134375 Properties | Data | Indicators
0 134475 CI 1344.00 L —
R e i 134875 Current Profile w
N W 1346 50 Visibilty AutoHide n
N =H and
134375 ursor Red, 1. Solid
| L1242 0n Harizortal Tick Marks. Grid Lines
ARG Selection Color I Gray
| 133375 YWertical Tick Marks. Grid Lines |
Ff’ B Scrolling
t | @ 2006 DpenE L Auta Scrall True
. pen E Ly, Shaow Right M argin False |
1010 2006002 1020 .v 1
,!D Connected | 0926 2006 16:30 10:46:44 AM
Cursor
General Information about the Crosshair.
# Chart - 15 min (ESZ6) =JoEd
Contract,., Add Indicator = 15 min * OHLC » Indicators,.. Select Profile - E | CH ‘d
Lol High 123080 Low 133825 Froperties | Data | Indicators
Open 1339.25 Close 1338.50 F1343.00 - —
b Current Profile Lv2
® 134625 Wisibility AutoHide A
i E Gnd and others
(134330 e Cursor Red. 1. Solid
| Calor I Red
ARE Shyle = solid
] "wfidth 1
Gf’ ® Horizontal Tick Marks, Grid Lines _
t 2006 Qpen E Ciy, LLC Selection Color I Gray

Yertical

,'D Connected | 09262006 16:30

Tick Marks, Grid Lines |v|

10:51:23 AM

Color

Specific color of the crosshair.
Style

Specific style of the crosshair whether it be a dotted line, a dashed line, a solid line, etc.

Width

The thickness of the cursor

Horizontal
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# Chart - 15 min (ESZ6) M=%
Caontract,.. Add Indicator = 15 min * QHLC = Indicators... Select Profile - E | g =
| jssnzs | [TOPetties | Dats | Indicators L
™, Current Profile w
£ 134675 Bl Grd and others A
i 1247 25 Curzor Red, 1, Sohd
B Hornizontal Tick Marks, Grd Lines
| m Show Grd Linez — True
ABC E Grid Lines LightGray, 1, Dash
] L1344 25 Colar [ ] LightGray
Ff’ Shyle E---1 Dash
t r1342.73 Width 1
s Label Color I Elack
134123 Label Font Microzoft 5ans Senl, 7 _Regular
Show Tick Mark:  True
F1339.75
A =l Tick Marks Black. 1. Solid
T P Colar I Elack
T Style E solid
H1336 75 "width 1
@ 2006 Open E Ciy, LLC Selection Calar 2 Gray
Yertical Tick Marks, Grid Lines A
10001 10003 B Scrolling k4
,!’D Connected | 09/28/2006 16:30 1:28:54 PM

Show Grid Lines

Shows the horizontal grid lines. In order to turn the horizontal grids lines off switch ‘True’ to ‘False’.

Contract,,. &dd Indicator = 15 min = COHLC - Indicators... Select Profile - ﬂ | df = 5
IE I Froperties | Data || Indicators
Current Profile |
e E Gnd and others A
i Curzar Red. 1, Solid
E Horizontal Tick Marks, No Grid Line:
| Show Grid Linez ~ False
20 (rid Lines True
Label Color Falze
QTJ 1 I akal Famt
\
Grid Lines

General information about the horizontal grid lines.
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View

& Chart - 15 min (ESZ6) =JIoEs
Contract,,. Add Indicator = 15 min * OHLC + Indicators,., Select Profile - E | d8 = J
IE ' Properties | Data | Indicators
b Current Praofile ™
B ﬁ;\ El Gnd and others A
i & Cursor Red. 1. Solid
El Horizontal Tick Marks, Mo Grid Line:
[ 343,25 Show Grid Lines | False
AEe = Grid Lines LightGray, 1. Dash
| 13423 Color [ LightGray
l‘?r' Lysma o Style =] Dash
t fidth 1
i 137,23 Label Color Il Black
@ 2006 Dpen E Cryp, LLC Label Font Microsoft Sans Serf, 7. Re
Show Tick Marks True |
P 10001 10003 e R ——— ]
,’O Connected | 09/258/2006 16:30 1:37:42 PM

Color
Specific color of the horizontal grid lines.

Style

Specific style of the horizontal grid lines whether it be a dotted line, a dashed line, a solid line, etc.

Width

The thickness of the horizontal grid lines.

Label Color

The color of the labels on the horizontal axis (Time)

Label Font

The font of the labels on the horizontal axis
Show Tick Marks

Shows ticks from the horizontal line to the labels. Can change visibility of the horizontal ticks by changing

‘True’ to ‘False’.

Tick Marks

General information about the Tick Marks.

& Chart - 15 min (ESZ6) M=)
Cantract... Add Indicatar = 15 min * OHLC + Indicators... Select Praofile - E | g = J
E ' I Properties | Data | Indicators
™ [1349.25 Currert Profile ~
B 1347 .50 E Honzontal Tick Marks, No Gnd Line:jAj
i Show Grid Line:  False
MR | O GridLines LightGray, 1. Dash
| L 134400 Color [] LightGray
A Style -] Dash
] "idth 1
(i} Label Color [l Black
+ Label Fant Microsoft Sans Sernif,7 Re
— F1338.75 Show Tick Marks True
Bl Tick Marks Black. 1. Solid
y I 133700 Calor Il Elack
o 2006 DpenE L. LLE Shyle i solid
a 10401 10003 Width E 1 |
,,O Connected | 09/28/2006 16:30 1:41:40 PM

Color
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Specific color of the ticks on the horizontal axis
Style
The style of the ticks on the horizontal axis

Width

The thickness of the ticks on the horizontal axis

Selection Color

The color you desired for the selected area if you were to drag you cursor from one point to another

Vertical
@ Chart - 15 min (ESZ6) M=)
Contrack... Add Indicator = 15 min * QHLC = Indicators... Select Profile - E | qp = ‘J
E ' Properties | Data | Indicators
™, Current Profile ™
i 5 election Color 2 Gray A
i B ertical Tick Marks, Grid Lines
Show Grd Lines  True
| E Gnd Lines LightGray, 1. Dash
Aza Coalar [] LightGray
[ Shyle -] Dash
(i) ‘width = 1
+ Label Caolor Il Elack
— Label Font Microzoft Sans Senf,7 Re
Show Tick Marks True
P r 227 00 B Tick Marks Black. 1. Solid
1 & 2006 Open E Ciy, LLT ' Colaor I Elack
e s i Style E Solid |
Ty 10/01 10403 width B 1 M)
i 3} Connected | 09/28/2006 16:30 1:43:46 PM

Show Grid Lines

Shows the vertical grid lines. In order to turn the vertical grids lines off switch ‘True’ to ‘False’
Grid Lines

General information about the vertical grid lines
Color
Specific color of the vertical grid lines
Style
Specific style of the vertical grid lines whether it be a dotted line, a dashed line, a solid line, etc.
Width
The thickness of the vertical grid lines
Label Color

The color of the labels on the vertical axis (Time)
Label Font

The font of the labels on the vertical axis
Show Tick Marks

Shows ticks from the vertical line to the labels. Can change visibility of the vertical ticks by changing ‘True’
to ‘False’
Tick Marks

General information about the Tick Marks
Color
Specific color of the ticks on the vertical axis
Style
The style of the ticks on the vertical axis

Width



View

The thickness of the ticks on the vertical axis

Scrolling
e 1
# Chart - 15 min (ESZ6) M=
Contrack,.. Add Indicator = 15 min * (QHLC = Indicators.,. Select Profile - E | g =
L | ' I Properties | Data | Indicators
b 134873 Current Profile ™
s Source Crozzhair A
8 igibility AutoHide
Grid and others
I , Cursor Red. 1. Solid
ARD Harizontal Tick Marks,. No Grid Line:
Selection Calor I Gray
(3] (EE @ Vertical Tick Marks, Grid Lines
t Lizarse | (B i ; =
s Ao Scroll True
2006
OpenE Liy. LLE Show Right Margin | False |
P 1041 10403 s
," Connecked | 09/25/2006 16:30 1:46:35 PM

Auto Scroll

Keeps the horizontal scroll bar at the bottom always at the most current price or at the most far right price

Show Right Margin

Offsets the scroll bar so the margin between the Y axis and the most current price is viewable

Chart Area 1
Misc

# Chart - 15 min (ESZ6)

Lo

Contract,.. Add Indicator = 15 min * CQHLC

Lk High 134775 Lows 1347 .25
~4 Open 1347 .25 Close 134775

Properties

Data | Indicators

F1348.73

+ Indicators.,. Seleck Profile = n | g =
|

Chart Area 1

E Mizc
Cuztom Ley [Collection]
Loweer Limit Auto
Ipper Limit Auto

F1339.73

F1337.50

114329 PM
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Custom Levels

Lower Limit

Allows you to set a specific price at which your viewable chart will not move below.

Upper Limit

Allows you to set a specific price at which your viewable chart will not exceed.

Contract (ei: ESZ6)

Appearance

-~

Chart - 15 min (ESZ6)

BEX]

Conkrack,..

add Indicatar « 15 min

- Indicators... Select Prafile - [& |

L,

High 1333.30  Loww 133300

™
W

X B> &

Open 133325 Close 1339.50

ST

% 2008 Open E Cryp, LLT

1347 75

134700

F1245.73

F1343.73

F1341.73

[r] 1081 1082

,'i Connected | 092212006 17:15

Properties | Data

ESZR

E Appearance
Chart Style
Color
Styles
"Wizible

B Candlestick
Bearizh
Bullish

B Mizc
Sezsion

Indic:ators
—

Spline [i]
Il Elack
[Collection]
True

Bl Bed
Bl Green

24 hours

Z:04:258 PM

Chart Style

Select the style of the chart you wish to view whether it be OHLC, Spline, Candlestick, Area, Stepline, etc.

Color

The color of the main contract chart

Styles

The specifics of the main contract chart

Visible

Whether or not the main contract chart is viewable

Candlestick



View

,m Chart - 15 min (ESZ6) Q@“

Conkract... &dd Indicator - 15 min = Spline = Indicators,.. Select Profile - E |
Ll High 134550 Low 134525 i Froperties | Data | Indicatars
0 1343.50 CI 134525 1
~4 Jiﬁ}‘- ’r'lll FSE 1347 75 ESZE L
S ‘L h\ M kIl || Appearance
B : Chart Style Spline
Color Il Black
| Styles [Collection]
Ara 1341 75 Wizible True
! B Candlestick
'Fr” r1339.75 Bearizh B Red
t Bullizh Bl Green
s 133773 B Misc
Session 24 hours
P
,'D Connected | 09/22/2006 17:15 2:15:52 PM
Bearish
The color of bearish candlesticks
Bullish
The color of the bullish candlesticks
Misc
B X
i
Contract,,, Add Indicator = 15 min * Spline = Indicatars... SelectProfile ~ [ | &= = "
High 134350  Low 1342.00 r Properties | Data | Indicators
k. Open 134325 Close 134825 ES76 -v-
Ll
o, w WY El Appearance
i Chart Style Spline
1344 50 Color Il Black
| Shyles [Collection]
- [1342.73 Visible True
B Candlestick
- F134H.00
(ig Bearizh Il Red
+ Faa9.25 Bullizh Bl Green
3 1237.50 El Misc
By [ S eszion 24 hours
&1 2 2006 Opan E Ty, LLC .
> & 24 hours
LY 0061002 05:15
— () Contract Setup -
Connected | 09/22/2006 17:15
"D 22 () Custam

Session

The time span you wish to view the chart
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24 hours

24 hours a day will be viewable
Contract Setup

The session will include only from the contract opening till the contract close
Custom

Select the time session you wish to view the contract
Additional Indicators

Appearance

ardleSkick, | Indicakors,., Select Praofile -

Properties | Data | Indicaters|

BB and[Close:ESER,20:2]
ESZR
|EBandClose:ESZ6,20:2)

134000 EM.&[DDSEZE SZE,ED]

BB and[Close:ESER,20:2]

1236.50 StdDev|Cloze:ESZE,20)

Triple[StdD ey [Close: ES2E,20).18;9:4
ATRIESZE14]

Orders

<

5:03:26 PM :

Select Profile -~

sndleskick = Indicators,..
|

Chart Style

154000 Color B DeepPink
Styles [Collection]
153650 Visible  True
B Data
[nput Close:E5Z6

Period of indi 20

S:05:44 PM
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View
Chart Style
The style of line the indicator chart will have, whether it be line, area, point, spline, etc.

Color

The color of the indicator chart

Styles

Specifics of the indicator chart

Visible

Whether or not the indicators is viewable

Data
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6) =JOEd

ndleskick = Indicatars,., Select Profile - E |

———

r Froperties | Data | Indicators |
oo || BBand|CloseESZE,20,2) ™|

v | [E5z8 ]
[BBand(Close ESZ6.20:2)

240,00 E kA Cloze:ESE6,20]

BB and[Cloze:ESZE,20:2]

1336.50 Stdlew|Cloze:ESEE,20)

Triple(StdD ey [Cloze:ESEE,20).18:9:4
ATRIESZE14]

Orders

£

S:03:26 PM .:

]

6) =[x

ndlestick = Indicators... Select Prafile - [& |

——————

[ Froperties | Diata | Indicatars |
EMAClose:E526.20) ||
El Appearance
Chart Style  Line
154000 Calar B DeepPink
Styles [Collection]
[l isible True
E Data
| Fiput Close:ES5F6

Perind of indi 20

50544 PM .

Input
Depending on the indicators, the data the indicator is having the information input from.

Period of indicator
The amount of data the indicators is viewing its information from based on the time or period indicated
Orders

Appearance

Font
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View

Customize the Font, Size and Style of the Fonts that appear on your charts and in the Data feed on the Chart;
aka OHLC (Top left corner by default).

# Chart - Bollinger Band: 15 min (ESZ6) =JoEd
Contract,., Add Indicator = 15 min * OHLC » Indicators,.., Select Profile - E | CH
[ 1 | :
E Properties | Data || Indicators
b Orders ™
o B Appearance A
i Font Arial, 6. 75, Regular [..|
E Color of Text
| Cancel Com JJll DarkRed =
133675 .
ARG Color of Fills [l Black
| Modity Corr [JJll DarkBlue
Gf’ o001 1o Fjl Haormal Orde [lll Black
t B Filter
i Cancel Com False
= Cancelled O False
Completed £ True
X N /x/\' Fills False -
! m LT PRI R el
,'. Connected | 0972002006 16:30 22706 PM
Color of Text
#! Chart - Bollinger Band: 15 min (ESZ6) Mi==
Contract,., Add Indicator = 15 min * OHLC + Indicators... Select Profile - E | b
Ll High 134100 Low 134075 Properties | Data || Indicators
R Open 134100 Close 134400 Orders 'v'
& Ebdit 13440 738 =] Appea[ance
18 &TR 0.3 Fant .ﬁlial,E_?E,Hegular
BiC
| Cancel Comm. Jlll DarkRed =
LEC Color of Fil: [l Black
todify Comm: il DarkBlue
Ff’ o o Homal Order [l Black
t E Filter
. Cancel Cornm. False
Cancelled Ord Falze
Completed Or True
X o Fill= Falze v
!i ﬂ@“imw \ (A I A IO i L
,'i Connecked | 09/20/2006 16:30 Z:29:00 PM

Cancel Command

The color of the text in an order indicator will appear by default Dark Red for cancel commands

Color of fills

The color of the text in an order indicator will appear by default Gray for Fills
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Modify Command

The color of the text in an order indicator will appear by default Dark Blue for Modify Commands

Normal Order

The color of the text in an order indicator will appear by default Black for Normal Order

Filter

# Chart - Bollinger Band: 15 min (ESZ6)

mEx]

Contrack, ..

add Indicator = 15 min

= OHLC

+ Indicators... Select Profile » [ | <&

L,

~
w

Ehdd 1348 536
ATR 166

High 1349.00 Lo
Open 134250  Close

134525
1242 .50

e m—

1043

Froperties | Data

Orders

Indicators

€ Conmected | 09)/20/2006 16:30

=i Filter :

Cancel Cornm. False
Cancelled Ord False
Completed O True
Fill= Falze
kodify Comme False
Rejected Orde False
"Wizible True
Working Orde Falze
Format

Agoregated Fi False

Full Farmat Falzse
MTlewlma 1T | i -

W

2135142 PM

Cancel Commands

This option offers the ability to view cancel commands on your chart, by default they are off.

Cancelled Orders

This option offers the ability to view cancelled orders on your chart, by default they are off.

Completed Orders

This option offers the ability to view completed orders on your chart, by default they are on.

Fills

This option offers the ability to view fills on your chart, by default they are off.

Modify Commands

This option offers the ability to view modify commands on your chart, by default they are off.

Rejected Orders

This option offers the ability to view rejected orders on your chart, by default they are off.

Visible

This option allow traders to turn the orders on or off without manually going thru each individual filter type. If
traders want to turn the viewable filters off simply change ‘True’ to ‘False’.



View

Working Orders

This option offers the ability to view working orders on your chart, by default they are off.

Format
# Chart - Bollinger Band: 15 min (ESZ6) Mi==
Contract,., Add Indicator = 15 min * OHLC + Indicators... Seleckt Profile - E | b

L 1 | .

IE Froperties | Data | Indicators
b Orders ™
H Madify Cormm: False A
B Rejected Orde False

Wizible True
| Waorking Orde False

LEC E Format

| Aggregated Fi False

Ff’ ,jm P ot FullFormat  Falze
t Crder 1D Falze
. Frice Falze =
[uaritiby True
pYe Ticket # Falze

| r\\ /_L/\’ Type False ”
it Mﬂt )
i €} Connected | 09202006 16:30 2:37:07 PM

Dat

Aggregated Fills
Shows each individual quantity and the price they traded at. They are faint grey color to indicate that they are
aggregated fills

Full Format

Indicates the type, the quantity, the contract and the side of how the trade was placed
Order ID

Price

Provides the price of the trade in the viewable filters

Quantity

Provides the quantity of the trade in the viewable filters

Ticket #

Provides the ticket number accompanied by the full format indicators in the viewable filters

Type

Provides the type of order that was placed in the viewable filters.

Data

a
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Information on the chart in relation to the cross-hairs on the charted contract.

0 o
a

Contract,., Add Indicator = 15 min * OHLC + Indicators.,. Seleckt Profile - E | b .-
|
High 133900  Low 133225 Froperties | Data | Indicators
~4 Open 133350 Close  1339.00
ol Ebda 1339.155 D ate/Time 0E:45 10403
ATR 0195 Last update 14:33.35
B Chart Area 1
| High 1333.00
Lo 1338.25
B Open 1332.50
| Cloze 1333.00
(3] u-m PR Top 1341.781
1 Biottam 1336.544
5 EMA 1339155
=8 Chart Area 2
StdDiew 1.31
> f Chart Area 3
% o3 ;TLE\ pu ATR 0.96
w € Connected | 09202006 16:30 2:38:37 PM
Date/Time

The time and date where the cross-hairs cross the X axis (bottom axis).

Last updated

The time the entire contract was most recently update with new data.

High, Low, Open, Close

The data is determined by the location of your cross-hairs on the chart. If the cross hairs are below the chart
they will cross at the low on the Y axis. If the cross hairs are above the chart they will cross at the high on the Y
axis.

Indicators
Channels

Channels
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# Chart - Bollinger Band: 15 min (ESZ6)

NEX)

ew

Contrack,,, Add Indicator = 15 min

* OHLC

= Indicators... Select Profile = [ |

IE.'

b
W

L Tl

F 134000

F1336.30

63 X 0| o - &
4

_ﬂi Connected | 0902002006 16:30

135025 | Properties | Data Indicatnrsl

= Channels s
Buollinger Band
Commadity Channel [ndex
Envelopes
K.eltnier Channel

= Moving Averages
E wponential Moving Average
Leaszt Square Maoving Average
Ralling Maoving Average
Simple Moving Average
Triangular Moving Awverage
Triple Maving Average

Y ariahle Moving Awveraoe [v]
0 @

4121139 PM

Bollinge

r Band

Will put a Bollinger Band on the chart directly

This indicator can be used to measure the relative highness or lowness of price.

Contract...

add Indicator = 15 min * CHLC

=l X

= Indicators... Select Profile = [

o)
IE Properties | Data | Indicators
., i IE}\P—'—’ . E! = Channels -
o . Ballinger Band L
Bollinger Band = @ Commadity Chantel Index I
p B El Appearance Ervelopes
| Colar [ LightBlue K.eltner Chatinel
- Yizible True wing Averages
4 B Data E=ponential Maoving Average
'Fr” B stdes 2 Least Square Maoving Average
3 [nput Close:ESZH | || Falling Maving Average
Period of indicator 20 Simple Moving Average
:‘_ Triangular Moving Average [V]
& i [
u ' 214141 PM
[ Save az Default
[] Create New Area ok l [ Cancel

149



OECTraderUserGuide

Commodity Channel Index
Will put a Chart below the existing Contract chart.

Compares Prices with its moving average.

Contrack,,, Add Indicator - 15 min * OHLC

+ Indicators,., Select Profile - E

High 134775 Lows  124€.00

Properties | Data | Indicators

\\ Open 134750  Close 134675 - Channels
‘-\-.‘:\\\;: Ehdes 1348 476 BD”ir‘lgEr Band
- . Commadity Channel [ndex
= B Commodity Channel Index @ Ervelopes
| E Appearance ~||keltner Channel
Chart Style Line * |wving Averages
AEC C - T . .
__ olor Bl DarkViolet E xponential b oving Average
(i 4 = Shyles [Collection] Least Square Moving &verage
+ Yizible True Ralling Moving Average
s B Data Simple Moving Average |
] [t E5Z6 Triangular Moving Average W
:@ Period of indicator 20 Ed
i @ 2152127 FM
[ Save as Default
k. l [ Cancel
Create Mew Area
Envelope

Will apply a envelop directly on the contract chart.

Plots above and below the moving average at a specified percentage.
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View

Contract... Add Indicator = 15 min * OHLC + Indicators... Select Profile - E

High 133850  Low 1337.50 Properties | Data | Indicators
0 1338.50 Cl 1338.00
~4 pen o = Channels
o
Bollinger Band
W Envelopes @ 8
P Commodity Channel |ndex

M | E Appearance Il Envelopes

| Calor [ LightCoral MU Eeltner Channel

- izible True oving Averages

*2/3 Data Exponential Moving 2Average

Ff’ Iriput Close:ESZ6 Least Square Moving Average

4 Percent 0.1 Ralling Moving Average

B Period of indicataor 20 Simple Moving Average _
] Triangular Moving Average b

[ 4 £d
w7 2:55:01 PM
[] Save az Default
4
[] Create Hew Area ] [ Gance

Keltner Channel.

Will apply 3 lines to the Contract chart

This indicator shows a central moving average line plus channel lines at a distance above and below.

k3 Zls
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" =[x
Contract...  Add Indicator = 15 min * OHLC » Indicators.., Select Profile - E 5
IE I Properties | Data | Indicatars
3 W = Channels s
N " Ballinger Band 1
Keltner Channel = @ Commodity Channel Indes 7
b B Appearance Ervelopes
| Chart Style Line K.eltner Channel
ol Color ] DarkGray ving Averages
Styles [Collection]) Exponential Moving Average
{?.-*’ Wisible True Least Square Moving Average
+ E Data Ralling Moving Awerage
. # deviations 1 Simple Moving Average
] InpLt ESZG Triahgular Moving Average
% E Period of indicatar 20 Tririe M"'ITI:”"' darans | [ }}
) @ 2:57:17 PM
[ ] Save as Default
[ Create Mew Area ok l [ Lancel

Moving Averages

# Chart - Bollinger Band: 15 min (ESZ6)

mEx]

Conkract,.. Add Indicator = 15 min * OHLE = Indicators,., Select Profile - E |
Ll High 134mon Low 134675 T Properties | Data | Indicators
-4 Open 134700 Close  1347.00 = Moving Averages [A]
W Ema 1348512 14':'”“ Exponential M oving Average
: Least Square Moving Awverage
— | Sl 086 hledian 057 1340 00 Ralling Moving Average =
| Fast R L ':'fa . Simple Moving Average
r 1336.50 Triangular Moving Awverage
Triple Moving Average
Fr" Wanable Moving Average
+ L Wweighted Moving Awverage
s . = Osgcilliator
sl {0, e &verage Directional Index
i Detrended Price Qzcillator
P L 1= Formentum ¥
A T IO TSI S | St m—
_ﬂ' Connecked | 09/20/2006 16:30 4:40: 37 PM

Exponential M.A. (EMA)



View

Will apply a line direct to Contract Chart.

EMA is an average of data calculated over a period of time where the most recent days have more weight.

Contrack,.. Add Indicatar = 15 min - OHLC ~ Indicataors... Select Prafile - E .-
JEI_I:Ijgh B TS e renl | [ | Propetties | Data | Indicators B
Exponential Moving Average @ Erwelopes A

K.eltner Channel

E Appearance i
- Mowing Averages

Chart Style Line V i i
Colar I DeepPink E xponential Mu:u-.-'lng Average
Styles (Collection) Leajst Squar.e Moving Average
Vizible True H.Dlllng Mu:uv.lng Average
= Data Su_'nple Moving j-'i'-.verage
Input Close:ESZE Tr!angular MDVlng Average
Period of indicator 20 T"Ffle ME“‘"”E! Average
Warable Moving Average
Weighted Moving Average
+ Merilliabnr )
32522 PM

[ Save az Default
[ ] Create Mew Area

Ok l [ Cancel

Least Square M.A. (LSMA)
Will apply a line direct to the Contract chart.
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Conkract... Add Indicatar = 15 min * OHLC = Indicators... Seleck Profile - E .-
(,EL-. . }m Properties | Data | Indicators E
s =
Least Square Moving Average @ Envelopes Rl
F.eltmer Channel
B G e . 1l = Moving Averages
Chart Style Line bl Exponential Moving Average
Color ] P'Iu_m Least Sguare Moving Awerage
S.t_l,l.les [Collection) Ralling Moving Average
Visible True Simple Moving Average
Sibola : Trangular Moving Awverage
Input . [:_IDSE'ESZE Triple Moving Average
RegressionOrder Linear ariable Moving Average
= P?"uds Weighted Moving Average
Window 35 + Merilliabnr L
32110 PM
[] Save as Default
)8
[] Create New Aea l [ Lancel

Rolling M.A. (RMA)
Will apply line direct to Contract chart.
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View

Conkrack,.. Add Indicatar = 15 min * OHLC + Indicatars,.. Select Profile - E _

E I Properties | Data | Indicators

ﬂ'i\.r:-ﬂ‘éi&m I iR Lisgesn | Ervelopes

Rolling Moving Average @ K.eltrer Charinel

- Mowing Averages
Exponential Moving Awverage

2 &

-

B Appearance

Eliail &z Line . hd Least Square Moving Average
Colaor Bl BlueViolet . .
- Ralling Moving Awverage
Styles [Collection] . .
= Simple Moving Average
"Wizible True . .
Trangular Moving Awverage
B Data . .
Triple Moving Awerage
[npLat Cloze:E5Z6 . .
K 0.1 Warable Moving Average
z Weighted Moving Average
%l Mecilliabnr !
3:28:56 PM

[] Save az Default
[] Create Mew fArea

] ] [ Cancel

Simple M.A. (SMA)
Will apply line direct to Contract chart.

The average of data calculated over a period of time.
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Contract... Add Indicator

~ 15 min T OHLC

+ Indicatars... Seleck Profile - E —

IE.
b

>
-

Simple Moving Average

=
=%

E Appearance
Chart Style Line v
Color [] DarkSeaGreen
Styles [Collection]
Wizible True
E Data
| npit Close:E576
Period of indicator 20
[] Save az Default
[] Create New frea [ Bk l [ Gance)

Triangular M.A. (TMA)

Direct line onto Contract chart

Properties | Data | Indicators

Envelopes
F.eltner Channel
- Moving Averages

Exponential M oving Average
Leazt Square Moving Average
Ralling Maoving Average
Simple Moving Average
Triangular Moving Average
Triple kaoving Average
Wariable Moving Average
Weighted Moving Average

+ Merilliatnr

2]

33039 PM

Average calculated over a period of time where the middle portion of the data has more weight.



View

Conkrack,,. Add Indicator = 15 min = OHLC = Indicatars,.,. Select Profile - H .-
IE l Properties | Data | Indicatars
L — Ervelopes A

Triangular Moving Average

=X]

B Appearance
Chart Style
Colar
Styles
Yizible
B Data
[mput
Perod of indicator

[] Save az Default

Line v
Bl Green

[Collection]

True

Close:E5Z6
20

[] Create Mew fres

(] ] [ Cancel

Triple M.A.

F.eltner Channel

- Moving Averages
Exporential M oving Average
Leazt Square Moving Average
Ralling Maoving Awverage
Simple Moving Average
Triangular Moving Awverage
Triple Maoving Average
Wariable Moving Awverage
Weighted Moving Average

+ Merilliatnr

< 2]

313407 PM

Applies 3 lines on Contract chart, the Slow, the Fast and the Median.
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Contract... Add Indicator ~ 15 min * OHLC » Indicators... Select Profile - E
High 134000  Low 1333.00 Properties | Data | Indicators
~4 Open 133373 Close 133925 1545 50 Ervelopes
o . K.eltrer Channel
Triple Moving Average @ 5 Moving Averages
B Appearance Exponential Moving Average
Chart Style Line " Least Square Moving Average
Colar Bl Red Ralling Maoving Awerage
Styles [Collection] Simple Moving Average
Wizible True Tnangular Moving Average
B Data Triple Moving Average
| nput StdDev[Close:ESZ6,20] Warniable Moving Average
B Perods Weighted boving Average
FaztPerniod 4 + Merilliabnr
. . < >
MedianPeriod 9
SlowPeriod 18 335146 PM
[ ] Save az Default
Q. l [ Cancel

[] Create Mew Area

Variable M.A.

Will apply line directly to Contract chart.
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Contract... Add Indicator = 15 min * OHLC + Indicators... Select Profile - E
High 134000  Low 133825 Propetties | Data | Indicators
Open 133875 Close 133823
I ) P “ [ 1246 50 L Ervelopes
Variable Moving Average @ K.Eltner Channel
- Moving Averages
B Appearance | Exponential Moving Average
Chart Style Line sl Least Square Moving Average
Calar E Chocolate Ralling M oving Average
Styles [Collection] Simple Moving Average
Yisible True Triangular Moving Average
= Data Trple Moving Awverage
Senszitivity 0.078 Yariable Moving Average
Yalatility R atio StdDey([Cloze:ESZE,20] weighted Moving dwverage

[] Save az Default

[] Create Mew Area

Ok l [ Cancel

Weighted M.A.

Direct onto the Contract chart.

+ Merilliabnr

2]

33TET PM

View

£3 Zlk

An Average where the greater weights are attached to the most recent data, it is calculated from the sum of the

day.
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)

=

-

<

-

i

(]

Conkrack,.. Add Indicator = 15 min * OHLC = Indicators... Select Profile - E
High 134225  Low 134150 Properties | Data | Indicators
o Open 134200  Close  1342.00 m 1546 50 Envelopes

Cuin amnn o K.eltner Channel

-

Weighted Moving Average

- \o/ed

= Moving Averages
E=ponential Moving Average

B Appearance
Chart Style
Color
Stylesz
Wizible
B Data
[ npLat
Perod of indicator

[ ] Save az Default
[] Create Mew frea

Line

B Green
[Collection]
True

StdDev[Cloze:E5Z6.20])
20

[e]

Leazt Square Moving Average
Ralling Maoving Average
Simple Moving Awverage
Triangular Moving Awverage
Triple Moving Average
Yariable Moving Average
Wwieighted Moving Average

Merilliabar
11}

fore]

[£]

Bl

F:39:14 PM

Ok l [ Cancel

Oscillator

160

Fa 1
¥ Chart - Bollinger Band: 15 min (ESZ6) M=}
Contract... Add Indicator « 15 min * QHLEC - Indicators... Select Prafile - [& |
Ll High 13m0 Low 1347s r Froperties | Data | Indicatars |
x\ Open 134800 Cloze 134725 = Oscilliator -~
Wl EMa 1347345 &verage Directional [ndex

Detrended Price Dzcillator
— | Eow 033 Median 040 kA ormentum
| Fast 0.50 ATR IZIET3 . Perfarmance
Price Ozcilliator =
Aa Rate OF Change
Relative Strength Indes
Stochastic
. wiilliar'z =R
o 'L 2l = Prices
g B Median Price
4 —— f”‘“ Twoical Price [V]
By @wmw <] m [
_.l"' Connected | 092002006 16:30 4:44:31 PM

Average Directional Index



View

Will appear below the Contract chart.
Will have three lines, ADX, -DI, +DI.

Contract... Add Indicator + 15 min * OHLC + Indicators... Seleck Profile E N

E&h A I I Properties | Data | Indicatars
—aul hi Al

" . . ' |0scilliator |

W Average Directional Index @ Average Directional Index b |
E Appearance _ Detrended Price Ozcillatar

. Chart Style Line [l M arnentumn

| Colar Il Black Perfarmance

). Styles [Collection] Price Qzcilliatar

3 Wigible True Rate Of Change

(Tr; Bl Data Relative Strenagth Indes

1 | it E5F6 Stachastic

B B Periods William's %R

v Period 14 Prices .
Trand Fallnwere V
i £d

| 2i4d 16 PM
[] Save az Default
Ok l [ Cancel
Create Mew frea

Detrended Price Oscillator
Will appear below Contract chart.

The Detrended Price Oscillator is used to "remove" the trend from the price. Comparing Closing or any other
price with it's moving average.
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L
s

Conkrack,,. Add Indicator = 15 min = OHLC = Indicatars.,. Select Profile - H | )
IEI | ! Properties | Data | Indicators
™ 134650 = O=zcilliator a

& Average Directional [ndex
Detrended Price Oscillator @ Detrended Price Oscillator
B Appearance - M ormentum
Chart Style Line A Pﬂ_ffﬂfmar'!'?ﬂ
Calar [] DarkSeaGreen Price Ozcilliatar
Shles [Collection] R ate Of Change
Wizible True Relative Strength [ndex
E Data Stochazhic
Input Cloze:ES5ZG ) whilliam's %=H res
Penod of indicatar 20 [+ Prices i
£ ¥
3:50:49 PM
[] Save az Detault
LK l [ Cancel
Create Mew Area

Momentum

Will appear below the Contract chart.



Contract... Add Indicator = 15 min * OHLC

View

e
s

* Indicators... Select Profile - H |_ﬂ

Momentum

El Appearance
Chart Style
Cilar
Styles
Wizsible

E Data
[ ript

E Periods
Wwindow

[ ] Save as Default
Create Mew Area

Line V
[ YellowGreen
[Collection]

True

Close:E5ZFbB

35

aE. l [ Cancel

Performance

Will appear under the Contract chart.

Properties | Data | Indicators

O szcilliator
Ayverage Directional Indes
Detrended Price Oscillator
b cmentum
Performance
Frice Oscilliator
Rate OF Chanige
Relative Strenagth Index

:>ﬁﬁ]

Stochastic
Wiliam's %R _a
¥l Prnices L]
35234 FM

Compares the current Close (or any other price) with the first Close value. Shows how much the Close price
was changed from the beginning.
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| D=

Contrack,., Add Indicatar = 15 min * OHLC + Indicators,., Select Profile -~ E |_E

High 134750  Low 134550 rm@ Propetties | Data | Indicators |
' |

| Open 134273 Close 134723 . | @ D zcilliator [A]
Performance N Y &verage Directional [ndex
@. Detrended Price Decillator
B Appearance b omentum
Chart Style Line e Performance
Colar 1 ED'_dE""-"d Price Ozcilliator =
Styles [Collection] Fiate Of Change
Yizible True Relative Strength Index
B Data Stochastic
Input Close:E5Z6 Wwiilliam's %A
[+ Prices had
) 1 |[i2]

39411 PM

[] Sawve az Default
Create Mew Area

Ok l [ Cancel

Price Oscillator
Will display below Contract chart.
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View

Cartract... Add Indicator + 15 min ~ OHLC - Indicatars... Select Profie - [ |j

IEMH I m Properties || Data | Indicators
L “ 1346 50 .| = Dzcilliator A
[=%

Average Directional Index
Detrended Price O zcillator

Price Oscilliator

B Appearance | b ornentum
Chart Style Line el Perfarmance
Color Bl Red Price Dsciliatar
Styles (Collection] Rate Of Change
"izible True Relative Strength Index
B Data Stochastic
Irput Close:E5Z6 Wwilliam's %A .
b ovingdiverage Simple + Prices 3]
Percentage True ra >
E Periods — —
Fastwindaw 9 St Fl
Slonaiindon 26
[ Save az Default
C Ok l [ Cancel
reate Mew Area

Rate of Change

Appears below Contract chart.
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Contrack,., Add Indicatar = 15 min * OHLC

Sl
e

+ Indicators,., Select Profile - _
s

High 1333.50 Laww  1336.50 !
-4 Open 133873 Close  1337.00 1346 50
Rate Of Change @
B Appearance
Chart Style Line v
Color I IndianRed
Styles [Collection]
Wizible True
B Data
[ npLat Cloze:E5Z6
Period of indicator 20
[] Save az Default
C OF. l [ Cancel
reate Mew Area

Relative Strength Index

Appears below Contract chart.

Properties | Data | Indicators

= Ozcilliator -~

Awerage Directional Index '
Detrended Price Dzcillator
b omentum
Performance
Price Osciliator
Rate OF Change
Relative Strength Index
Stochastic
wiilliarn's =R

< 2]

JaTI1E PM

Compares upward movement of the Close price with the downward movement resulting in a value which ranges

from 0 and 100.
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View

a o
s
Conkrack,.. Add Indicatar = 15 min * OHLC + Indicatars... Select Profile - E |j

IE I | Properties | Data | Indicators

RN o :"FI! mestan - Dscilliator |
- Average Directional Index
Relative Strength Index @ Detrer?ded Frice Oscilator
B Appearance - b ormentum
Chart Style Line || Performance
Color I DarkCyan Price Ozcilliator
Styles [Collection] Fate Of Change
Wizible True Relative Strength [ndex
E Data Stochastic
Input E5Z6 wiilliarn's %R o]
Period of indicator 20 3 = ]
3:59:09 PM

[] Save az Default
Create Mew Area [

LK l [ Cancel

Stochastic (%K, %D)
Appears below Contract chart.

Indicator helps to find trend reversal searching for a period when close prices is close to low price in up trending
market or close prices is close to high price in down trending market.
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Contrack,.. Add Indicatar = 15 min

* OHLC

e
Fa

- Indicators... Select Profile - [ |_ﬂ

High 1340.00
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William’s %R (%R)

Places the charting below the Contract chart.

This indicator is used to measure overbought and oversold levels.
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Median Price (Median)
Places a line directly on the Contract chart.

Mid-point value of daily prices.

Typical Price (Typical)
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Appears directly on the Contract chart.

The average value of the daily prices.

Weighted Close (Weighted)
Appears direct to the Contract chart.

Average value of daily prices, only difference is that the closing price has extra weight as the most important
price.

Trend Followers

#! Chart - Bollinger Band: 15 min (ESZ6) M=)
Contrack,,, Add Indicator = 15 min = OHLC + Indicators,,, Select Profile -~ H |
IE. I f Properties | Data | Indicators |
b = Prices [A]
Eh tedian Price
Typical Price
B 134000 Weighted Cloze
| = Trend Followers
1336 50 kACD
Ao b azs [ndex
(?IJ Tangent of Linear Begreszion
N TR =
s Yolatility
i = Yolumes
=]
" Accumulation/Distribution
b I e [(m E aze of Movement [v]
% v e~ a I
_ﬂ' Connected | 09/20/2006 16:30 4:14:56 PM

MACD (MACD, Histogram, Signal)
Appears below Contract chart.

Compares two moving averages of prices. Is used with its 9 day Exponential Moving average as signal.

Mass Index (Ml)
Below the Contract chart.

developed to predict trend reversal by comparing difference and range between high and low prices.

Tangent of Linear Regression (Tangent)

Appears below Contract chart.

TRIX (TRIX)
Below Contract chart.

Based on triple moving average of Closing Price and its purpose is to eliminate shorter cycles.

Volatility
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Average True Range (ATR)

Appears below Contract chart.

Measures commitment comparing the range between High, Low and Close prices .

Standard Deviation (StdDev)

Appears below Contract chart.

Difference between values (Closing Price) and average.

Volatility (Volatility)

Appears below Contract chart.

Volatility Chaikins (CHV)

Appears below Contract chart.

Difference between high and low prices, indicates the top and bottom of the market.

Volatility Ratio (VR)

Appears below Contract chart.

Volumes

View
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Accumulation/Distribution (A/D)
Appears below Contract chart.

Estimates the strength of price movement with the relationship between volume and prices.

Ease of Movement (EoM)
Appears below Contract chart.

Uses volume to estimate how strong the price trend is.

Money Flow Index (MFI)
Appears below Contract chart.

Compares upward changes and downward changes of the volume weighted typical prices.

Negative Volume Index (NVI)
Appears below Contract chart.
Should be used with PVI.

Changes only if the volume decreases from the previous day.

On Balance Volume (OBV)
Appears below Contract chart.
Measures positive and negative volume flows.

Volume is added if the closing price moves up and subtracted if the closing price moves down.

Positive Volume Index (PVI)
Appears below Contract chart.
Should be used with NVI.

Changes only if the volume decreases from the previous day.

Price Volume Trend (PVT)



View

Appears below Contract chart.
Cumulative volume total.

Calculated by using the relative changes of the Close price.

Volume Oscillator (VO)
Appears below Contract chart.

Tries to identify any trends in volume, comparing two moving averages; one with a short period and the second
with a longer period.

Communications

Research

This window displays important messages that consist of major market issues sent from the brokers to the entire
OEC population. It also displays Risk messages such as available credit, etc.

Each time a research appears it will be accompanied by a topic first then a message. The broker can make it as
specific as possible for quick reference by using the seven templates. The topics are Indices, Currencies, Energies,
Grains, Metals, News, and General.

3:41:39 PM RISK
Rigk wiolation Max credit = 0 USD,Order would need credit of 6012.52
S0 [zash available iz 37862.48 1SD]

To access Research:

a. From Communications menu options, click on the "Research Window"; if the option has a check next to it then
it's available to view; if it does not have a check then it isn’t available to view.

b.  From View menu, click on Research in order to make it highlighted.

Chat

Allows one customer to directly ask questions, get quotes, place orders, etc with a broker. The broker answers the
questions/comments via the CHAT box.

We highly recommend most questions be transmitted via the CHAT box. It is the most streamline method of
communication.

Chat

3:28:36 PM to DanielA:Hella | have a question. | | Drarield
3:28:50 PM to DanielA:w'hat iz the curent zymbol of the

mini 5P 500 7

3:29:17 PM Danielh: The curent symbaol for the mini S&P

A00 iz ESUR

W-I0-DF Dl b D il - Tl—nde - |

In order to initiate chat with a BROKER, select their name (i.e. OECBroker9) and type your message in the open row
at the bottom. Once you have entered your text you will be offered the SUBMIT button. Click on the SUBMIT button
and the broker you selected will receive your message. The drop box is there for your reference so you can repeat
your self with previous comments or say the same thing to a different broker by just clicking into the drop box and
selected the previously written text.

To access Chat:
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a. From Communications menu options, click on the CHAT option. If it is already checked it will uncheck the
CHAT option and it'll be unavailable to chat.

b.  From View menu, click on Chat in order to make it highlighted.
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Reports

Access Reports

Each report can be filtered by one account or all and date ranges. They can be viewed in PDF or Excel format.
Access any one of the following reports.

Daily Fills

Shows the dalily fills for the designated dates indicated above.

Daily Activity

Daily Activity is the number and contracts that you traded on the dates indicated above.

Working Orders

Working orders are the orders that are working or have been working from the date increment from above.

Rejected Orders

This report indicates all the rejected orders within the dates entered above.

Order Statistics

The number of orders placed, orders cancelled, orders filled, open orders, the number bought and the number
sold for the date above and within the contracts that were traded.

Order Ticket Statistics

The method the orders were placed weather they be AOE, Turbo, Rapid or DOM and the order statistics for
each order method.

P/L Summary

The Profit and Loss for each trade placed and the order statistics, for the date(s) provided above.

Chat History

The chat history is recorded for quick reference and for security reason. This allows traders and brokers to view
previous conversations between trader and broker.

News History

The Research comments that have been presented by the Brokers to the entire OEC population. These
messages are important details from the broker involving major Futures issues.

Order Details
Provides a detailed description of each trade made and the necessary identifications for each detail within the

order placed.

Daily Positions

Daily Positions represents the positions for the account above between the dates indicated.

Trade Log

Provides a detailed description of the trades placed. The trade log provides the time, side, the contract, the

price and the amount at which each trade was place.

Open Orders
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Provides the list of open orders that exist with in that account.
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Setup

Shortcut Manager

Allows you to customize the hotkeys for a vast amount of OEC Trading options.

Actian Kepsz i
File
Lagan
Logoff
E st
Orders
Abbreviated Order Entry Chrl+1
Turbo Order Extry Madifiers:
R apid Order Entry )
Drepth OF b arket Order Entry Ctl [] Shift [] A
Contract Setup Key:
Clear After Subrmit
1 | | Reset
Turn on Mew Order Canfirmation
Restore Defaulq [ Ok ] [ Lancel ]

Quick Start

Allows you to view the quick start menu which has a direct link to the Quick Start Guide, Depth user’s guide and alll
the contact info for customer service and support.
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m Quick Start = E

=

HEE N BN L i
open e cry"

Welcome to Open E Cry's direct access trading software.

We encourage vou to vigit our quick start guide and in depth uzer's
guide.

If vou have any questions please visit our Live Help or call 200-520-
5308 or 814-792-2590,

of the goftware for future reference.

A link to the quick =tart guide will be available under the "Toolbox™ menu

[w] Show an startup




Toolbox

Contract List
Display the Open E Cry's Contract List web page with your default browser.

URL: http://www.openecry.com/platforms/available.cfm

Contract Margins
Display the Open E Cry's Contract Margins web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/margins.cfm

Contract Specs
Display the Open E Cry's Contract Specifications web page with your default browser.

URL: http://www.openecry.com/traderstoolbox/contract.cfm

Glossary
Display the Open E Cry's Glossary web page with your default browser.

URL.: http://www.openecry.com/traderstoolbox/glossary.cfm
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Help

Contact Us

Display the Open E Cry's Contact web page with your default browser where you can direct questions/comments to

our staff.

URL: http://www.openecry.com/company/contact.cfm

About

Displays the current information of the platform that the trader is currently running.

m.ﬁ.hnut

HEE B BN L |
open e cry

DECTrader Demo
Yerzion 3.1.0.8

& 2008 Open E Cry, LLC
&l rights rezerved
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Open Live Account

Open Live Account (DEMO ONLY)

Demo Only
Display the Open E Cry's Online Application with Electronic Signature web page with your default browser.

URL: https://www.openecry.com/openaccount/applyonline.cfm
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Advanced Features
Advanced Orders

Order Flags
# ESZ6 - Depth of Market

B[]

L

= | [F & - = | (Ml |  DEmo2saz0 -
Qty: 0% Total P/ $1.000.00
Poz: ]

<
[ 1324.00 789
13225 R
3839 12ze50
122825 R
122500 [
122775
13227 RNl
N - B

Order Flags

@ Nore O GTC O FOE O 10C

Good Till Cancelled (GTC)

Order remains on the books until cancelled and can be filled at an undesirable time if forgotten.

Fill or Kill (FOK)

LMT orders which, if not filled immediately, are cancelled.

Immediate or Cancel (I0C)

LMT orders which, if not filled immediately, are cancelled.

OCO Orders

OCO (One cancels other) is a pair of orders sent together.
Currently only Limit and Stop orders of one side (buy limit/buy stop or sell limit/sell stop) are supported.

1. Tosend OCO orders, user needs to check OCO toolbar button, and then send two orders in usual way.
Another way to enter a single pair of OCO orders, user could hold SHIFT key while clicking.

2. After clicking first order, the price would be marked with different color, until second order is entered. To cancel
OCO order entry after first order is entered, user should uncheck OCO toolbar button (or release SHIFT key).

Working OCO orders are displayed in blue color by default.
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"o X
A | & 5 ‘? 3 S [l | DEMO47094 -

Qty: 5% Total PAL: $0.00

Foz 0 ¥ Confirm orders

-,

o

Buw 5 ESSR LMT 1324.50
Buw 5 ESSR LMT 1326.00

[

Yes ] [ Mo

:

il 1326.00

1325.75
2720 132550

| 2660 | 1325.25

4240 1325.00

I 1324.75

1324.50
Left Click: OO LIMIT

[ Buy MET ] [ o bo Last

| senmkT |

Stop Limit/Trailing Stop

#! ESZ6 - Depth of Market Mi==
< | [ 5|5 wl[ AlfS |8 | DEMo47094 -
Qty: 5% TatalPAL: $0.00
Fos: 0
Bl | -
275 1326.75
132650
1326.25
132600
1325.75
132550
1325.25
132510
1324.75
-
| BwMkT || Gotolast || selmkT |
[] Stop Limit [ ] Trailing Stop
Factor: Factor: 0.25 {3}

Advanced Features
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Stop Limit (STP LMT)

e  Orders are used like STP orders, but execution is restricted to the limit price or better. They do not become
MKT orders once the STP price has been reached

e  Buy STP LMT is activated when the commodity is bid or traded at or above the STP level, the order will not be
filled unless the price remains at or drops below the limit level

e  Sell STP LMT is activated when the commodity is offered or traded at or below the STP level, the order will not
be filled unless the price remains at or rises above the limit level

®  No order can be guaranteed an execution

Trailing Stop (Tr STP)

A complex stop-loss order in which the stop loss price is set at some fixed percentage below the market price. If the
market price rises, the stop loss price rises proportionately, but if the stock price falls, the stop loss price doesn't
change. This technique allows an investor to set a limit on the maximum possible loss without setting a limit on the
maximum possible gain, and without requiring paying attention to the investment on an ongoing basis

Trailing Stop (Stop Limit) order is a Stop order which “follows” the market price. By checking “Trailing Stop” checkbox
all stop/stop limit orders would be sent as Trailing Stop/Stop Limit orders.

The Control key negates this checkbox settings, so right clicking with “CTRL” key pressed sends trailing stop order, if
this checkbox isn’t checked, or sends normal stop order if the checkbox is checked.

The “Factor” value controls the minimum market price change that would case order to “trail”. Its minimum value is
one tick of selected contract.

Trailing Stop order could be sent as an individual order, or as a linked (bracket) order.
Trailing Stop order couldn’t be part of OCO orders pair.

Working Trailing Stop orders displayed in green color by default.

How to execute
1. Check the Box next to STOP LIMIT and/or TRAILING STOP.
2. The Cursor will indicate when a trailing stop/stop limit order is available

3. Right click above the market to initiate the trade

Bracket Options

Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Brackets are group of orders — master and 1 or 2 linked. Linked orders are activated when master order is filled.
They are mostly used to create a “bracket” around open position, so they are called brackets. However, user can
enable only one part of bracket (Stop or Limit)

When Bracket checkbox of corresponding price is checked, order would be sent as bracketed order. However, if
order is closing or reducing existing open position, it would not be sent as bracket.

Factors are price difference between bracket orders and master order

When user is moving mouse pointer over the order entry area, places for bracket orders are indicated on the
opposing side in orange, and prices also highlighted (see picture).

If market bracket order is sent, bracket prices are determined against current bid/ask price.
If both Limit and Stop checkbox are checked, linked orders will be sent as OCO order pair.

If only Stop is checked, it is possible to send linked Trailing Stop order (by checking Trailing Stop checkbox also).

184



Advanced Features

Inactive Linked orders are displayed with + sign (see picture), and could be modified or cancelled separately from
master order, but master order cancellation would cancel inactive Linked orders.

Buy Bracket

Click on the Buy Bracket Box to activate the
option of placing a BUY Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Sell Limit

If sell LMT is checked then the bracket will have
the Sell LMT side attached being placed above
the market on the opposite side of the Buy
Bracket

This factor indicates how far from the BUY order
the Sell LMT will be

Sell Stop

If sell STP is checked the bracket will have the
Sell STP leg attached

This indicates where the sell STP will be placed
from the BUY bracket

Sell Bracket

Click on the Sell Bracket Box to activate the
option of placing a SELL Bracket

If the Box is filled in with a box then only one of
the two legs are checked

Buy Stop

If buy STP is checked then the bracket will have
the buy STP leg attached being placed above the
MKT on the opposite side of the Sell Bracket

This factor indicates how far from the Sell order
the Buy STP will be bracketed

Buy Limit

If buy LMT is checked the bracket will have the
Buy LMT leg attached be placed beloved the MKT
on the opposite side of the initial trade

This indicates where the sell STP will be placed
from the BUY bracket
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#

2DNR: Two-day range (high-low) that is narrower than any two day range in the preceding 20 days.

3Day: The 3-day market pattern as described in “The Taylor Trading Technique by George Douglass Taylor. B=Buy, S=Sell,
SS=Short Sale.

3DNR: Three-day range (high-low) that is narrower than any three day range in the preceding 20 days.

A

Account balance: The amount of money or debt in an account.

Account Number: (1) A series of characters (alpha and/or numeric) used to identify a customer account or relationship. (2) The
remitting financial institution's account serviced by the receiving bank. (3) The identification assigned by a financial
institution often called the account number.

Account position: The balance and current holdings of an account.

Ask: An indication by a trader or a dealer of a willingness to sell a security, a futures, or other financial instrument. The price at which
an investor can buy. Syn. offer. See also bid; quotation.

Asked: The price that someone is willing to accept for a security, futures or other financial instrument. The ask portion of a quote is
the lowest price anyone is willing to accept at that time.

Asked Price: The price at which sellers offer securities, futures or other financial instrument to buyers. Also called offer price.

At-the-money: An option with a strike price equal to the current price of the instrument, such as a stock, upon which the option was
granted.

At-the-opening order: An order that specifies it is to be executed at the opening of the market or of trading or else it is to be
canceled. The order does not have to be executed at the opening price, but within the opening range of prices.

At or better: (1) In a buy order for securities, futures or other financial instruments it is purchasing at the specified price or under it
(2) For a sell order, it is selling at the specified price or above it. See limit order

B

Bear Market (bear/bearish): A market in which prices are declining. A trader who believes prices will move lower is called a
“bear.” A period of generally failing prices and pessimistic attitudes.

Beta: A measure of an investment's volatility. The lower the beta, the less risky the investment.
Bid: An indication of a trader of a willingness to buy a security. The price at which an investor can sell.
Bid-offer spread: The difference between the bid price and the offer price.

Break-even point: (1) The point at which gains equal losses. (2) The price a market must reach for an option buyer to avoid a loss if
he exercises. For a call, it is the strike price plus the premium paid. For a put, it is the strike price minus the premium paid.

Broker: An individual or firm that charges a fee or commission for executing buy and sell orders placed by another individual or firm,
floor broker in commodities futures trading, a person who actually executes orders on the trading floor of an exchange; an
account executive (associated person) as the person who deals with customers and their orders in commission house
offices.

Buy Limit order: An order to a broker to buy a specified quantity of a security at or below a specified price (called the limit price).

Buy on close: Buying securities, futures or other financial instruments at the end of a trading session at a price within the closing
range.

Buy on opening: Buying securities, futures or other financial instruments at the beginning of a trading session at a price within the
opening range.

Buy Stop Order: An order to buy a market that is entered at a price above the current offering price and that is triggered when the
market price touches or goes through the buy stop price.

Buying Hedge (or Long Hedge): Buying futures contracts (or other financial instruments) to protect against possible increased cost
of inputs slated for futures uses. See Hedging.
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C

Closing balance: The balance of entries posted to the account at the close of the statement period.

Closing price: The price at which transactions are made just before the close on a given day. A number of transactions are often made
at this time and they will be included over a range of prices. See also closing range.

Commission: (1) A fee charged by a broker to a customer for performance of a specific duty, such as the buying or selling of futures
contracts. Banks charge commissions for issuing letters of credit, accepting drafts drawn under letters of credit, entering
foreign exchange transactions for their customers, custodial services, acting as fiscal agent, etc. Fees are paid by banks to
others for various services and include fees to foreign exchange brokers for arranging foreign exchange transactions. A
commission must be fair and reasonable, considering all the relevant factors of the transaction. (2) Sometimes used to refer
to the Commodity Futures Trading Commission (CFTC).

Commodity: An entity of trade or commerce, services, or rights in which contracts for future delivery may be traded. Some of the
contracts currently traded are wheat, corn, cotton, livestock, copper, gold, silver, oil, propane, plywood, currencies,
Treasury Bills, Treasury Bonds, and Stock Indexes.

Contract Month: The month in which deliveries to be made in accordance with a futures contract.

D

Day Trade: The purchase and sale of a futures or an options contract in the same day, thus ending the day with no established
position in the market or being flat.

Delivery Month: A calendar month during which a futures or options contract matures and becomes deliverable.

F

FOK (Fill or Kill): FOK (Fill or Kill) When an order is given to a broker that must immediately be filled in its entirety or, if this is
not possible, totally canceled.

G

GTC (Good until cancelled): GTC (Good until cancelled) orders are generally held on file and considered to be active unless
cancelled by you. Upon expiration of the contract, the GTC order will be automatically cancelled.

Initial Margin: The minimum value on deposit in your account to establish a new futures or options position, or to add to an existing
position. Initial margin amount levels differ by contract. Brokerage firms set the level of Initial Margin required, and it may
change at any time at their discretion. Increases or decreases in Initial Margin levels reflect anticipated or actual changes in
market volatility. Also called "Initial Performance Bond." (See also Margin)

Intrinsic Value: The absolute value of the in the money amount; that is, the amount that would be realized if an in the money option
were exercised.

10C (Immediate or Cancel): 10C (Immediate or Cancel). An order requiring that all or part of the order be executed immediately
after it has been brought to the market. Any portions not executed immediately are automatically cancelled. This is used for
large orders where filling quickly can be difficult.

L

Leverage: Essentially, it allows an investor to establish a position in the marketplace by depositing funds that are less than the value
of the contract. The use of borrowed assets by a business to enhance the return to the owner's equity.

Limit Order: An order in which the customer sets a limit on either price or time of execution, or both, as contrasted with a market
order, which implies that the order should be filled at the most favorable price as soon as possible.

M

Margin Call: A call from a brokerage firm to a customer to bring margin deposits back up to minimum levels required by exchange
regulations; similarly, a request by the clearinghouse to a clearing member firm to make additional deposits to bring
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clearing margins back to minimum levels required by clearinghouse rules. A demand upon an investor to put up more
collateral for securities bought on credit.

Market If Touched Order: An order which becomes a market order if the specified price is reached.

Market Inversion Index (MI1): Market Inversion Index. A very short term momentum indicator. This indicator is used to determine
which side of the market to be on for the close and early session the following day. When the MII flips from, for instance,
long to short on the market close, a trader should go short with the intent of covering the short either in globex or early in
the next day’s session. This is a short term indicator for aggressive traders.

Market On Close Order: A buy or sell order which is to be executed as a market order as close as possible to the end of the day.

Market Order: An order to buy or sell futures contracts, stocks or other financial instrument which is to be filled at the best possible
price and as soon as possible. A limit order, in contrast, may specify requirements for price or time of execution.

Moving Average: A mathematical procedure to smooth or eliminate the fluctuations in data. Moving averages emphasize the
direction of a trend, confirm trend reversals, and smooth out price and volume fluctuations or “noise” that can confuse
interpretation of the market.

N

Net position: (1) A financial institution has a position in foreign currency when its assets, including future contracts to purchase, and
liabilities, including future contracts to sell, in that currency are not equal. An excess of assets over liabilities is called a net
"long" position and liabilities in excess of assets result in a net "short" position. A long net position in a currency which is
depreciating results in a loss, because with each day, that position (asset) is convertible into fewer units of local currency.
A short position in a currency which is appreciating represents a loss, because with each day, satisfaction of that position
(liability) costs more units of local currency. (2) The difference between the open long (buy) contracts and the open short
(sell) contracts held by any one entity in any one futures contract month or in all months combined.

R

Round Turn: The combination of an initiating purchase or sale of a futures contract or other financial instrument and offsetting sale
or purchase of an equal number of futures contracts or other financial instruments, of the same specifications. Commissions
and fees for transactions are charged on the round turn.

S

Sell Limit order: An order to a broker to sell a specified quantity of a security at or above a specified price (called the limit price).

Stop Limit Order: An order to buy or sell a certain quantity of a certain security at a specified price or better, but only after a
specified price has been reached. Essentially a combination of a stop order and a limit order.

Stop Loss: A risk management technique used to close out a losing position at a given point. A stop loss order is placed at the given
point.

Strike price: A specified price at which an investor can buy or sell an option's underlying financial instrument. The exchange rate,
interest rate, or market price that is guaranteed by an option transaction.

Symbol: Code by which futures are identified on a futures exchange; a corporation which provides the facilities to trade futures
contracts
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